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Disclaimer

Any responsibility or liability for loss or damage in connection with the use of this 
product and the accompanying documentation is disclaimed by Thrane & Thrane. The 
information in this manual is provided for information purposes only, is subject to 
change without notice and may contain errors or inaccuracies. 

Manuals issued by Thrane & Thrane are periodically revised and updated. Anyone 
relying on this information should acquire the most current version e.g. from thrane.com 
or from the distributor. 

Thrane & Thrane is not responsible for the content or accuracy of any translations or 
reproductions, in whole or in part, of this manual from any other source.

Copyright

© 2012 Thrane & Thrane A/S. All rights reserved. Printed in Denmark.

Trademark Acknowledgements
• Windows and Outlook are registered trademarks of Microsoft Corporation in the 

United States and other countries.

• Inmarsat is a registered trademark of the International Maritime Satellite 
Organization (IMSO) and is licensed by IMSO to Inmarsat Limited and Inmarsat 
Ventures plc. 

• Other product and company names mentioned in this manual may be trademarks or 
trade names of their respective owners.

Company web site

 www.thrane.com

http://www.thrane.com
http://www.thrane.com
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Safety summary 1

The following general safety precautions must be observed during all 
phases of operation, service and repair of this equipment. Failure to comply 
with these precautions or with specific warnings elsewhere in this manual 
violates safety standards of design, manufacture and intended use of the 
equipment. Thrane & Thrane assumes no liability for the customer's failure 
to comply with these requirements.

Disposal

Old electrical and electronic equipment marked with this 
symbol can contain substances hazardous to human beings 
and the environment. Never dispose these items together 
with unsorted municipal waste (household waste). In order to 
protect the environment and ensure the correct recycling of old equipment 
as well as the re-utilization of individual components, use either public 
collection or private collection by the local distributor of old electrical and 
electronic equipment marked with this symbol. 

Contact the local distributor for information about what type of return system 
to use.

RADIATION WARNING

During transmission this system radiates Microwave power from 
all sides of the satcom antenna unit. High levels of radio 
frequency radiation are considered harmful to health. Although 
no single value has been agreed upon by all countries, the 
American National Standards Institute (ANSI/IEEE C95.1-1992) 
recommends that people should not be exposed to radiation 
stronger than 1 milli Watt per square centimeter at the 
frequencies used in this system. Accordingly, the operator of the 
system should ensure that no person should approach within 1 
meter of the satcom antenna when the system is transmitting.
iii
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About the manual 2

Intended readers

This manual is a user manual for the AVIATOR 200/300/350 
system. The readers of the manual include aircraft personnel and 
passengers who want to use the SwiftBroadband Services.

For the daily use of the system there are no specific skills required. 
However, it is important that you observe all safety requirements 
listed in this manual, and operate the system according to the 
guidelines in this manual.

Manual overview

This manual has the following chapters:

• Introduction contains an overview of the SwiftBroadband 
services and a brief description of the system.

• Getting started explains how to connect a PC and make the first 
call.

• Operating the system explains in detail how you can access the 
Internet, make phone calls, start a streaming session, send 
telefaxes and SMS messages.

• Advanced use provides detailed information on the web 
interface, the phone book and some administrative tasks.

Note The AVIATOR 200/300/350 system is available in two 
versions: 

AVIATOR 200/300/350 approved to RTCA specification 
DO- 178B level E and DO-254 level E

AVIATOR 200D/300D/350D approved to RTCA 
specification DO-178B level D and DO-254 level D.

In general descriptions the nomenclature AVIATOR 
200/300/350 covers both versions. Where necessary, 
the Level D system is specified as AVIATOR 
200D/300D/350D.
iv
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• Troubleshooting contains information on how to get help and a 
short troubleshooting guide.

• 2-Wire Handset use provides a description how to use the 2-
Wire Handset.

Note that this manual does not cover the installation, 
configuration and setup of the system. It does neither cover how to 
customize the system for specific applications. For more detailed 
information how to customize the system to specific needs, to set 
up interfaces and configure network setup and routing 
functionality see the AVIATOR 200/300/350 Installation and 
maintenance manual.

 You find the part numbers for related manuals in the next section

This manual may not always reflect the latest software 
functionality of your AVIATOR 200/300/350 system. To obtain the 
latest version of the manual, please enter the Thrane & Thrane 
web site at: http://www.thrane.com and download the latest 
version, or acquire it from your distributor.

Software version

This manual is intended for the AVIATOR 200/300/350 system with 
the following software versions:

• AVIATOR 200/300/350 (Level E) software version: 1.05 (Level E) 
or greater1

• AVIATOR 200D/300D/350D (Level D) software version: 2.00 
(Level D) or greater

1. This software version is not mandatory, but recommended.
v
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Related documents

The below list shows the documents related to this manual and to 
the AVIATOR 200/300/350 system.

Typography

In this manual, typography is used as indicated below:

Bold is used for the following purposes:

• To emphasize words. 
Example: “Do not touch the antenna”.

• To indicate what the user should select in the user interface. 
Example: “Select SETTINGS > LAN”. 

Italic is used to emphasize the paragraph title in cross-references.

Example: “For further information, see Connecting Cables on 
page...”.

Title and description Part number

AVIATOR 200/300/350 Quick Guide 98-127720

AVIATOR 200/300/350 Installation and 
maintenance manual

98-127093

AVIATOR Wireless Handset and Cradle, User 
Manual

98-129599

AVIATOR Wireless Handset and Cradle, 
Installation and Maintenance Manual

98-129600
vi
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Introduction 1

Welcome

Congratulations on the purchase of your AVIATOR 200/300/350 system. This 
system is an aeronautical broadband system providing simultaneous high-
speed data and voice communication via satellite through Inmarsat’s 
SwiftBroadband (SB) services.

With SwiftBroadband the cabin applications e-mail, telephony, Internet and 
intranet access, VPN, video streaming etc. are available.

In this chapter

In this chapter you can read about:

• Services, features and interfaces,

• About SwiftBroadband

Telephone

(secure)
Internet Wireless

Email

SMS
ISDN Fax
1
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Services, features and interfaces

Overview

The following drawing shows the AVIATOR 200/300/350 system with 
connected communication devices and available options:

Wireless IP Handset

Wireless IP Handset
2 Services, features and interfaces
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Services

The SwiftBroadband services available depend on the type of satcom antenna 
installed and the current elevation angle to the satellite. The following table 
shows the services available for the supported antenna types.  

For current support of Inmarsat services check at 
http://www.inmarsat.com/Services/Aeronautical/SwiftBroadband/.

The current elevation angle is shown in the web interface of the AVIATOR 
200/300/350.

Coverage for AVIATOR 200 and AVIATOR 300

The following map shows the coverage for I4 satellites including coverage 
areas for 20° and 45° elevation angle. Some of the SwiftBroadband services 

SwiftBroadband 
service

Satcom antenna

AVIATOR 200

LGA (Class 15)a
AVIATOR 300

IGA (Class 7)

AVIATOR 350

HGA (Class 6)

Standard IP 
background

Up to 200 kbps Up to 332 kbps Up to 432 kbps

IP streaming classes 8/16 8/16/32/64/128 kbps 8/16/32/64/128 kbps, 
X-Streamb

Circuit-switched 
standard voice

Yes Yes Yes

ISDN service or 
3.1 kHz audio 
(Premium voice)

No Elevation > 45° Yes

a. The elevation needed for services with this antenna type is > 20°.
b. Data rates are up to 512 kbps. Check with your service provider for activation.
Services, features and interfaces 3
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for AVIATOR 200 and AVIATOR 300 require a certain elevation angle, see the 
table on the previous page.
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Features

The AVIATOR 200/300/350 system has the following features:

 SwiftBroadband unit providing an ‘always on’ data connection of up to 
432 kbps.

 Full duplex, single or multi-user

 Automatic satellite selection.

 Built-in PBX interfacing to two 2-wire connections, one ISDN interface and 
WLAN in the SBU, with integrated SIP server.

 Standard voice.

 3.1 kHz audio for modems, G3 fax, 14.4 kbps high quality voice etc.1

 ISDN voice for Secure communication, G4 fax etc.1

 ISDN data for video conferences etc.1

 Built-in Router option with DHCP and Network Address Translation (NAT).

 Access to built-in web interface for daily use on all LAN connectors.

 Built-in Wireless option (WLAN) IEEE 802.11 b/g.

 Built-in web interface for configuration using the Maintenance connector 
on the SBU front plate.

 Remote management

The AVIATOR 200/300/350 system does not affect the operation of an Iridium 
system.

1. AVIATOR 300 and AVIATOR 350.

Note The availability of some services depends on the installed satcom 
antenna. Check the section Services on page 3 for an overview of 
services available for the antenna types LGA, IGA and HGA.
Services, features and interfaces 5
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Interfaces

The AVIATOR 200/300/350 system has the following interfaces:

 Two 2-wire connections for telephone

 One ISDN interface

 Six Ethernet interfaces

 One Wireless interface (WLAN) IEEE 802.11 b/g

 One Ethernet interface for system configuration on the SBU front plate (It is 
used for installation, service and maintenance. It is not used during flight 
time.)

Built-in router and Wireless options

The AVIATOR 200/300/350 system offers a built-in router as an option. With 
this option multiple users and applications can use the system simultaneously. 
Without this option only the first device that connects to the SBU will be 
allowed on the Internet.

The system also offers a built-in WLAN option for wireless communication 
devices and a WLAN antenna approved for aeronautical use. This includes full 
WLAN routing functionality.

If ordered, these options are enabled in the AVIATOR 200/300/350 from the 
factory. If these options are not included from the start, the system can be 
upgraded at a later stage. Then you receive the FLEX key for the purchased 
options and enter it in the AVIATOR 200/300/350 web interface.

PBX telephone exchange

The built-in PBX telephone exchange unit of the SBU connects two direct 2-
wire POTS interfaces for faxes, handsets, headset interface boxes etc., as well 
as an ISDN interface for ISDN phones, fax machines or secure communication. 
The built-in PBX of the SBU can route VoIP calls that are terminated in the SIP 
server of the SBU.
6 Services, features and interfaces
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Tool for setup and use: The web interface

Use the built-in web interface of the 
SwiftBroadband Unit (SBU) to access the system 
settings. The web interface is accessed from a 
computer connected to one of the LAN connectors 
or using the WLAN interface of the SBU. The web 
interface is shown in an Internet browser. No 
additional installation of software is needed.

For further information on the web interface, see 
Getting to know the web interface on page 62.

Handsets

The following handsets are recommended by Thrane & Thrane.

AVIATOR Wireless Handset and Cradle

The AVIATOR Wireless Handset is used to 
receive and make calls. The handset connects to 
a wireless access point using Wireless Local 
Area Networking (WLAN). 

See the AVIATOR Wireless Handset and Cradle, 
User Manual for a description of the keys and 
LEDs of this handset and how to make calls.
Services, features and interfaces 7
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TT-5621B 2-Wire Handset and TT-5622B 2-Wire Cradle

The 2-Wire Handset is used to receive and to make calls.

See 2-Wire Handset use on page 101 for a description of 
the 2-Wire Handset and how to use it.

Sigma7 handset and cradle

The Sigma7 handset is used to receive and to 
make calls.

See the separate user manual for a description of 
how to use the Sigma7 handset.

ICG DECT Cordless handset

The ICG DECT Cordless handset system is used to 
receive and to make calls. 

See the separate user manual for a description of 
how to use the ICG DECT Cordless handset. 
8 Services, features and interfaces
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About SwiftBroadband

Geostationary Inmarsat satellites

The Aero SwiftBroadband services are based on 3 geostationary satellites 
situated above the equator. Geostationary means that the satellites are 
stationary in relation to Earth, i.e. they rotate at a speed that matches the 
rotation speed of the Earth. Each satellite covers a certain area, this is also 
called a footprint. It supports a number of powerful narrow-spot-beams 
making the SwiftBroadband service available virtually anywhere on the earth, 
this is shown on the coverage map on the next page.

The satellites are your connection to the Internet and telephone networks, and 
they are run and managed by Inmarsat. Inmarsat is the leading provider of 
global mobile communications services. Inmarsat keeps track of which 
SwiftBroadband Units are logged on to the system, assigns a free channel and 
manages the data when a network connection is established or a call is made.

SwiftBroadband coverage

The SwiftBroadband service is a mobile satellite service that offers high-speed 
data up to 432 kbps (512 kbps with X-Stream), voice telephony and ISDN. 
Using this service users can access e-mail, corporate networks and the 
Internet, transfer files and make telephone calls. 

The SwiftBroadband service by Inmarsat is accessible worldwide, except the 
extreme polar regions. It is covered by the three satellites. The following figure 
shows a world map with the areas covered by each of the three I4 satellites 
and an elevation angle of 0°.
About SwiftBroadband 9
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Inmarsat’s I4 satellite coverage (AMER, EMEA, APAC)

Note The map above shows coverage for SwiftBroadband. The map does 
not represent a guarantee of service. The availability of service at the 
edge of coverage areas may fluctuate.
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SwiftBroadband services

SwiftBroadband consists of the basic services:

• Symmetric ‘always on’ data connection, packet switched (PS)

• Voice and ISDN (voice and data) service, circuit switched (CS)

• Short Messaging Service (SMS)

The following figure shows how the services are accommodated in a 
SwiftBroadband channel.

With SwiftBroadband you can combine multiple packet-switched services with 
one circuit-switched service active at the same time.

Limitations

Limitations for the services with AVIATOR 200, AVIATOR 300 and AVIATOR 350 
are listed in Services on page 3.

Circuit switched (dialed) service

SwiftBroadband also provides high-quality telephone services (including 
secure mode). The following types of circuit switched connection are available:

• Standard voice. A connection for voice only. The voice signal is compressed 
to 4.0 kbps, which reduces the bandwidth use and consequently the cost. 
This is also called AMBE2.

Note The SwiftBroadband system only supports one circuit-switched call 
at a time per AVIATOR 200/300/350 system.
About SwiftBroadband 11
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• 3.1 kHz audio 1 (Premium voice). A high quality connection which can be 
used for Premium Voice, G3 fax or analog modems. The signal is 
uncompressed 3.1 kHz audio, which allows for optimum voice quality.

• ISDN 1. A high quality connection which can be used for voice (3.1 kHz 
Audio), G4 fax or 64 kbps UDI/RDI data.

Packet switched service

The IP-based packet-switched service provides a data rate of up to 432 kbps. 
The packet switched service offers two types of connections: In Standard IP 
mode, the service is shared among users of the system, providing a 'best 
effort' service. This type of connection is ideal for e-mail, file transfer, and 
Internet and intranet access. The user pays for the amount of data sent and 
received. This type of connection is also called Background IP.

You can also use the SwiftBroadband service at a pre-determined quality of 
service, i.e. a specified streaming data rate. This service is called Streaming IP. 
This type of connection is ideal for time critical applications like live video over 
IP. The user pays for the duration of the connection (per minute charge). For 
streaming classes supported see Services on page 3. 

1. ISDN services and 3.1 kHz audio (Premium voice) are available for elevations 
higher than 45 degrees for systems with an IGA, i.e. AVIATOR 300. ISDN 
services and 3.1 kHz audio (Premium voice) are not available for AVIATOR 200. 

Note The AVIATOR 200/300/350 system supports up to 11 concurrent 
packet-switched connections at a time. For use of packet switched 
services also see Features on page 5.
12 About SwiftBroadband
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Messaging service

SwiftBroadband provides a generic messaging service for sending and 
receiving messages to and from the AVIATOR 200/300/350 system.

Supplementary telephone services

The following supplementary telephone services are available:

• Call hold

• Call waiting

• Call forwarding

• Voice mail

• Call barring

These services are typically set up during the initial configuration of the 
system. For further details on Call forwarding see Forwarding a call on 
page 47, the other supplementary telephone services are described in detail in 
the AVIATOR 200/300/350, Installation and maintenance manual.

Service Provision for SwiftBroadband

Before you can use the SwiftBroadband service you must have a contract with 
an Inmarsat service provider (ISP). The service provider provides the telephony 
and data services and invoices you for the services used. For information on 
Service Providers who will provide you with easy and reliable satellite 
communications services go to www.thrane.com, then Aeronautical, Contacts, 
ISP contacts.

Note that the use of the X-Stream service must be activated by your service 
provider.
About SwiftBroadband 13
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Airtime pricing principles (charged by time or volume)

When using the system note that the circuit switched services and streaming 
classes (packet switched) are charged by the time the service is being used, 
while the standard IP and SMS services (packet switched) are charged by the 
volume of data transferred or number of messages sent.

The following image shows how the various applications are supported by the 
SwiftBroadband service. 

For information on service availability see Services on page 3.
14 About SwiftBroadband
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Getting started 2

In this chapter

In this chapter you can read about:

• Accessing Internet, e-mail, etc.

• Making the first call

For information on how to install, configure and service the system, see the 
AVIATOR 200/300/350 Installation and maintenance manual. You find more 
detailed guidelines on the applications in Operating the system on page 23.

Line of sight

To use the satellite network, the AVIATOR 200/300/350 satcom antenna must 
have free line of sight to the satellite.

Note The system cannot communicate with the satellite and go online 
when the aircraft is inside a hangar.

Picture: airphototicino
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Availability of airtime services

To be able to establish a data connection or make a call the SIM card installed 
in the AVIATOR 200/300/350 system must be activated by a service provider. 
This is taken care of during installation and configuration of the system. The 
service provider handles SwiftBroadband system activation, billing and 
technical support that is related to the communication network.

The AVIATOR 200/300/350 system is operational and ready to use when the 
aircraft is powered up and the aircraft’s navigational system has finished its 
initialization. Check whether your aircraft is equipped with a sign saying that 
the satcom system is ready for use before you start your application. 

System default settings

The telephone (2-Wire) and ISDN lines are available as soon as the system has 
registered with the SwiftBroadband service. 

Per default Internet, e-mail and other IP services are available as plug-and-
play, no further configuration is needed. The system is set up to automatically 
start the standard background IP connection when connecting a PC, PDA or 
other device using Ethernet or WLAN.

Important With the plug-and-play functionality a computer automatically 
establishes a connection to the Internet and starts transferring 
data as soon as you start using the Internet, e-mail or other IP 
services. See Unintended use of bandwidth on page 29 for 
information how to set up your computer to avoid unintended 
and possibly costly use of bandwidth.
16
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Accessing Internet, e-mail, etc.

Before connecting to the LAN/WLAN interface

For the LAN or WLAN interface to work without any further setup, the 
connected computer or IP device must be set up to obtain an IP address and a 
DNS server address automatically. This is usually the case for most PCs. If you 
are in doubt you can check your PC, see the step-by-step procedure how to do 
this in IP address and DNS server address setup on page 64.

Overview

With SwiftBroadband the cabin applications e-mail, Internet and intranet 
access, VPN, etc. are available. The connection type recommended for these 
applications is the Standard data connection, which is also the default setting. 
For a more detailed description of the Standard data connection see Packet 
switched service on page 12.

Important To optimize airtime and bandwidth usage we recommend to 
disable the feature for automatic PC software update in your 
computer.
Accessing Internet, e-mail, etc. 17
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Depending on how your system was set up initially there are two scenarios 
that may be applicable when you use a data connection to access the Internet, 
e-mail etc.:

Check with your system responsible whether your system is set up to 
automatic activation of a standard data connection (plug-and-play).

Standard data 
connection

Benefits Drawback

Automatic start 
(system default)

Plug-and-play Risk of unintended use of costly 
airtime, i.e. Windows update 
downloads, frequent check for 
new mail etc.

Manual start from 
the web interface 
(This must be 
configured during 
initial 
configuration.)

Efficient 
bandwidth 
usage

You must start the web interface at 
http://192.168.0.1 and click once to 
start a connection.

Online software updates of the 
connected devices (PC, 
smartphone etc.) should only be 
performed when you are 
connected at the office or at home 
where bandwidth and airtime are 
less costly. Check the 
documentation for the device how 
to disable automatic software 
updates.
18 Accessing Internet, e-mail, etc.
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Practical instructions

To access the Internet or use your e-mail program do as follows:

1. Switch on your PC or PDA.

2. For LAN: Connect your LAN cable (standard Ethernet) between the network 
connector on your computer and one of the LAN connectors installed in the 
aircraft. 
For WLAN: Check that the WLAN icon in the status bar of your operating 
system indicates that the WLAN connection has been established.

3. Start your application, e.g. Internet browser or e-mail program. 
If you cannot establish a connection, the automatic activation of a 
standard data connection may be disabled in your system. Then you can 
start a connection manually. 
How to establish a connection manually see Start or stop a Standard 
connection on page 32 or Start or stop a Streaming connection on page 33 
for detailed instructions. To learn more about the web interface see 
Accessing and navigating the web interface on page 65.
If you want to change the start-up mode of the standard data connection 
contact your system administrator to change the setting in your network 
user group for Automatic activation to Enabled or Disabled. This is 
described in detail in the AVIATOR 200/300/350 Installation and 
maintenance manual.

Note To access the WLAN for the first time you must enter the Network 
Name (SSID) and the encryption key, if any.

WLAN access details Your AVIATOR system

Network Name (SSID)

Encryption key
Accessing Internet, e-mail, etc. 19
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Making the first call

Introduction

The following sections provide a short guide to making calls. For more 
detailed information, see Making or receiving a phone call on page 38.

If you want to use a SIP-enabled IP handset to make a call see Using a SIP-
enabled IP handset or smartphone on page 51.

Making a call from the AVIATOR system

To make a call from a phone or handset connected to the system, press

00 <country code> <phone number> followed by # or off-hook key.

Example: To call Thrane & Thrane Inc. in USA that has the country code 1 and 
the phone number 7574639557 press 
00 1 7574639557 #

Making a call to the AVIATOR system 

To make a call to a phone connected to the AVIATOR 200/300/350 system 
(ground to air), dial

+ <Mobile number>

• + is the prefix used in front of the country code for international calls. The 
Prefix depends on from which country you make the call. It is 011 if you call 
from the USA.

• Mobile number: The mobile number of the system you are calling. The first 
part of the number is always 870, which is the “country code” for the 
SwiftBroadband system.

Note There are two Voice numbers, one for 3.1 kHz Audio and one for 
Standard Voice. 
20 Making the first call
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Example: If you are calling from the USA and the mobile number for 
standard voice is 870772420567 on your system, and you want to 
make a call to the system, dial 011 870 772420567.

You find the voice numbers in the documentation from your service provider or 
noted on the AVIATOR 200/300/350 Quick Guide. See also Viewing and editing 
the mobile numbers on page 73. Make sure you have the international dialling 
code for the country you want to call from. 

If a call to the AVIATOR 200/300/350 system is not answered the caller can 
leave a voice mail message with Inmarsat’s voice mail service. Then an SMS is 
sent to the AVIATOR 200/300/350 messaging system to alert you that there is a 
voice mail message. For further details see Receiving a voice mail message on 
page 41.

Making a call from one AVIATOR system to another

To make a call from one system to another, press 00 <Mobile number>.

Note If you have connected a fax, make sure that the incoming call type 
on that 2-wire interface is set to 3.1 kHz Audio. This is to avoid that 
the fax rings and answers an incoming Standard call. This is usually 
taken care of during initial configuration of the system. See the 
AVIATOR 200/300/350 installation and maintenance manual for 
further information.
Making the first call 21
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Operating the system 3

In this chapter

In this chapter you learn in detailed step-by-step descriptions about: 

• Using a computer (most common applications)

• Using a phone or fax machine

• Using a SIP-enabled IP handset or smartphone

• SMS service

Selected scenarios

The application examples in this chapter are mainly based on the default 
configuration and some typical application scenarios. If you have specific 
requirements to the interface setup and configuration of your system refer to 
the AVIATOR 200/300/350 Installation and maintenance manual. 

Tool for setup and use: The web interface

Use the built-in web interface of the SwiftBroadband Unit (SBU) to access the 
system settings. The web interface is accessed from a computer connected to 
one of the LAN connectors or using the WLAN interface of the SBU. The web 
interface is shown in an Internet browser. No additional installation of 
software is needed.

In this manual you find information and instructions for the parts of the web 
interface that you might need when using the system. The parts of the web 
interface that deal with installation, configuration or maintenance are 
described in detail in the AVIATOR 200/300/350 Installation and maintenance 
manual.
23
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The following drawing shows the menus available in the web interface. The 
topics in gray are mainly used during installation and maintenance of the 
system, they are described in detail in the AVIATOR 200/300/350 Installation 
and maintenance manual.

For more detailed information about using the web interface see Advanced 
use on page 61.

Services and interfaces

The following table shows the supported combinations of services and 
interfaces, and which types of equipment can be used.
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Service

Interface on the system

Phone/Fax 
(RJ 11)

LAN (RJ 45) or 
Wireless

ISDN (RJ 45)

Ci
rc

ui
t S

w
itc

he
d

3.1 kHz 
Audio 

(Premium 
voice)a

Analog 
telephone

SIP-enabled IP 
handset

ISDN telephone

G3 Fax machine G4 Fax machine 
(If it supports G3 Fax)

Secure 
telephone 
STU/FNBDT

Standard 
Voice 

(AMBE)

Analog 
telephone

SIP-enabled IP 
handset

ISDN telephone

Data, 
UDI or RDIab

G4 fax machine, 
computer with ISDN 
interface or secure 
communications

Pa
ck

et
 S

w
itc

he
d Data

multi-user
Computer or 
smartphone

Data
single-user

Computer or 
smartphone

SMS Computer with 
web interface

a. AVIATOR 300 with IGA (Class 7): Elevation angle must be larger than 45°. 
AVIATOR 200 with LGA (Class 15): This service is not available.
For current support of Inmarsat services check at 
http://www.inmarsat.com/Services/Aeronautical/SwiftBroadband/.

b. Check with your service provider that the RDI service is available on the Ground 
Infrastructure network.
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Using a computer

LAN and WLAN interfaces

If the Built-In Router option is activated in your system you can connect 
several PCs and other IP devices to the AVIATOR 200/300/350 system. Then 
the system operates as a router. It handles IP data traffic so the AVIATOR 
200/300/350 system can be used with multiple computers for e-mail, Internet 
access, VPN, intranet and other applications that use the packet switched 
connection.

If you have purchased the Wireless Option you can connect multiple 
computers and other IP devices to the system via the Wireless Access Point. 
For more information on these options see Built-in router and Wireless 
options on page 6.

To connect a computer to the AVIATOR 200/300/350 system you have several 
possibilities:

• Use one of the six LAN connectors (Ethernet) to connect user computers or 
other LAN equipment. Check how many of the LAN connectors are available 
in your installation and where to find them in the cabin.

• If available, use the Wireless Option to connect computers and other 
devices using IP to the network. For this you need the network name (SSID) 
and encryption key, if any.

There is also the front Maintenance connector on the front plate of the 
SwiftBroadband Unit. This connector may not be accessible during flight. It is 
reserved for service and maintenance purposes.

Customizing network use

With the built-in router functionality the AVIATOR 200/300/350 system offers a 
flexible use of the data channel of the SwiftBroadband service. The system 
administrator can configure the use of the data channel by defining network 
26 Using a computer
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user groups and profiles. The following picture gives an overview over the 
parameters and functions involved.

An IP device that is connected to the AVIATOR 200/300/350 system will 
automatically be assigned to the default network user group, if it is not 
specified otherwise. The default setting of this group is a standard data 
connection with automatic IP address allocation and automatic activation of 
the connection.

The AVIATOR 200/300/350 system is flexible and can be configured to specific 
requirements for your network use, e.g. manual activation of the Internet 
connection, activating video streaming, a server on the network or a fixed IP 
address on one of the devices. For this you need to set-up network groups 
with specific primary and/or secondary profiles. You can find detailed 
description in the AVIATOR 200/300/350 Installation and maintenance 
manual.

Network user groups

To manage the use of the bandwidth and the applications allowed for the 
individual user the system administrator can set up network user groups. The 
following paragraphs describe how network user groups are used in the 
AVIATOR 200/300/350 system. 

When you connect an IP device (a computer, smartphone, etc.) to the AVIATOR 
200/300/350 system the system will find out which network user group the 
device belongs to. To do this the system uses the following information:

• The port the device is connected to, i.e. one of the 6 Ethernet ports, 
Wireless or the SBU maintenance connector (reserved for service and 
maintenance).

• The device’s IP address.

• The device’s MAC address.
Using a computer 27
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In the default configuration of the network user group called DEFAULT GROUP 
a specific IP address or the unit’s MAC address are typically not needed. The 
DEFAULT GROUP uses the background IP data connection. 

If you want to read more about how to customize the AVIATOR 200/300/350 
system and how to set up network user groups and traffic profiles to meet 
specific data traffic requirements see the AVIATOR 200/300/350 Installation 
and maintenance manual.

Connecting to the Internet

You can connect your PC or other IP devices e.g. your smartphone to the 
Internet and use e-mail, VPN, file transfer applications etc. The following 
sections describe two typical applications: Starting a standard data connection 
and a streaming data connection.

 Accessing the web interface in the AVIATOR 200/300/350 system

When the computer and the AVIATOR 200/300/350 system are ready you can 
access the built-in web interface of the system to display various information, 
use the SMS service or start and stop a data connection.

To check the connection of your computer to the web interface of the system 
do as follows:

1. Power up your computer.

2. For LAN: Connect your LAN cable (standard Ethernet) between the network 
connector on your computer and one of the LAN connectors installed in the 
aircraft. 
For WLAN: Check that the WLAN icon in the status bar of your operating 
system indicates that the WLAN connection has been established.

3. Open your Internet browser and enter the default IP address of the 
AVIATOR 200/300/350 system: http://192.168.0.1.

Note To access the WLAN for the first time you must enter the Network 
Name (SSID) and the encryption key, if any. For further details 
see WLAN access details on page 19.
28 Using a computer
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You may have to disable the Proxy server settings in your browser. For 
further information, see Proxy server settings on page 62.

4. The web interface opens and the page DASHBOARD is displayed. On the 
Dashboard you see the current system information (Example below: 
AVIATOR 350).

You can configure the system to your specific requirements. This is typically 
done during the installation and initial setup of the system. See the AVIATOR 
200/300/350 Installation and maintenance manual for detailed information 
how to customize the interfaces of the system and how to set up network user 
groups and profiles to manage data traffic and bandwidth usage.

Unintended use of bandwidth

The system default setting is automatic activation of a standard data 
connection. With this setup you connect the PC to the cabin network and start 
using the applications. You do not have to connect to the web interface to start 
using the services, it is plug-and-play. This setting involves a high risk of 
being charged for airtime and bandwidth when connected computers perform 
automatic software updates. These updates are not limited to the Windows 
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system itself, but also other installed programs ( e.g. browsers, Java and 
Media or Flash players) might do updates. Some do updates even without 
prompting before the download is complete. 

To avoid unintended use of bandwidth through automated background 
services the system can be set to not automatically connect to the Internet 
when you connect your computer or other IP equipment (PDA, smartphone, 
webcam, etc.) to the network interface. You set this in the web interface.

However, selecting manual activation alone will not prevent these updates, 
but only delay them until the connection is activated. The only way to be sure 
is to disable updates in all programs, which can be a difficult task. Please 
check with you IT department for assistance on this. If you want to start a data 
connection in this mode you must access the system’s web interface and 
activate your data session, standard IP and/or streaming IP, from the 
Dashboard.

You can set a limit for the use of data services that can be downloaded over 
the AVIATOR 200/300/350 system for safeguard against unintended use of 
bandwidth. For further details see Setting data limits on page 81.   

Understanding Standard and Streaming data connections

The SwiftBroadband 
network supports two 
types of IP data 
connections to the 
Internet: Standard 
data and Streaming 
data. The figures on 

Note Online software updates of the connected devices (PC, smartphone 
etc.) should only be performed when you are connected at the office 
or at home where bandwidth and airtime are less costly. Check the 
documentation for the device how to disable automatic software 
updates.

Note Optimize airtime and bandwidth usage: You are charged for the 
bandwidth used for automatic software updates. We recommend to 
disable this feature in your computer.
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this page show how the bandwidth of up to 432 kbps is used when set-up as 
Standard connection (left) and as Standard and Streaming 128 kbps (right).

• With a Standard data connection all users that have signed on the network 
share the bandwidth available. This type of connection is ideal for TCP/IP 
traffic such as e-mail, file transfer, and Internet and intranet access. 
Standard data services are charged by the volume of data transferred.

• With a Streaming data connection you get a guaranteed, high-priority 
connection, ensuring seamless transfer of data with guaranteed bit rate 
and Quality of Service. This type of connection is ideal for time-critical 
applications like live video over IP. Streaming classes are charged by the 
time the service is being used (per minute charge). 

The system administrator can set up various types of connections using 
network user groups, profiles and traffic flow filters. For information how to 
define these most appropriately see the AVIATOR 200/300/350 Installation 
and maintenance manual.

Data sessions available for the current user are displayed under PROFILES ON 
LAN or STREAMING PROFILES ON LAN at the bottom of the Dashboard.

The AVIATOR 200/300/350 system supports the use of network user groups. 
These network user groups define which type of IP connections are allowed for 
each group. Each network user group has then one or more profiles for 

Important You must always close the Streaming connection manually to 
finish the connection properly. You must click Stop streaming 
in the web interface to close the streaming connection. It is not 
enough to disconnect the equipment. As long as the 
connection is active you are charged for the service.
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various applications. You can only see, start and stop profiles of the network 
user group you belong to.

• Primary profiles are listed in the left side and secondary profiles (if any) are 
listed to the right.

• Profiles that are currently active are displayed as a link with the text “Stop 
<name of profile>”.

• Profiles that are ready to be activated are displayed as a link with the text 
“Start <name of profile>”.

Start or stop a Standard connection

On the Dashboard you can see under PROFILES ON LAN whether a standard 
connection is active or not.

To start or stop a Standard connection for your Network user group do as 
follows:

1. Open your Internet browser and enter the IP address of the AVIATOR 
200/300/350 system (default: http://192.168.0.1) to access the Dashboard of 
the web interface.

2. Locate PROFILES ON LAN at the bottom of the page.

Note The system administrator can start and stop data sessions for all 
users in the network user groups. For further information, see Start 
or stop any data session on page 77.
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3. Click Start <name of profile>, in this case: Start Standard, or Stop <name of 
profile> to stop the connection.

4. Click Refresh to update the current state of the connection(s). Note that 
there might be some latency when updating the connection status, you 
might have to wait and click Refresh again to update the Dashboard to the 
current state.

Start or stop a Streaming connection

The AVIATOR 200 is limited to the streaming classes 8 and 16 kbps.The 
AVIATOR 300 supports the streaming classes 8, 16, 32, 64 and 128 kbps. The 
AVIATOR 350 supports the streaming classes 8, 16, 32, 64, 128 kbps and X-
Stream. Note that streaming classes are charged by the time the service is 
being used (per minute charge). A started Streaming session will stay active 
until you manually stop it.

On the Dashboard you can see whether the network user group you belong to 
has been set up to support streaming sessions.

Note The PDP context for a data session is not activated before any unit in 
the LAN tries to communicate, e.g. sends a DHCP request. You can 
also remotely start a data connection, see Remote activation with 
SMS on page 86.

Note You can only start a Streaming session if the administrator has set 
up a Streaming profile for your user group. Contact your system 
administrator if you need a streaming connection.
Using a computer 33



Chapter 3:  Operating the system

SBLiteUM.book  Page 34  Tuesday, March 13, 2012  1:44 PM
To start or stop a streaming session do as follows:

1. Open your Internet browser and enter the IP address of the AVIATOR 
200/300/350 system (default: http://192.168.0.1) to access the Dashboard of 
the web interface.

2. Locate STREAMING PROFILES ON LAN.

3. Click the link with the name of the Streaming profile that has been set up 
for you.

Always manual activation of a Streaming connection

The streaming data connection cannot automatically be activated, you must 
start it manually in the web interface. This is a safety measure to prevent the 
system from unintended use of bandwidth. 

A started Streaming session will stay active until you manually stop it by 
clicking on the link for the streaming class on the Dashboard.

Important If you have selected and started a Streaming connection as 
your primary profile, the LAN or WLAN interface will be running 
a Streaming connection until you stop it. It is not enough to 
disconnect the equipment from the interface to stop the 
streaming connection.
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Using a phone or fax machine

Available interfaces

Several types of voice equipment connect to the system:

Standard analog phone or G3 fax1 machine: The system has two phone 
interfaces for connecting standard analog phones or fax machines.

ISDN phone1 or G4 fax machine1: The system has one ISDN interface for 
connecting an ISDN phone or a fax machine.

SIP-enabled IP phone (smartphone): the system has an integrated SIP server 
for connecting a SIP-enabled IP phone. For more details on setting-up and 
using a SIP-enabled IP phone see Using a SIP-enabled IP handset or 
smartphone on page 51.

Check the cabin installation to locate the connectors for telephones and fax 
machine.

For information on how to connect to the interfaces, see the AVIATOR 
200/300/350 Installation and maintenance manual.

Selecting a call type

This is typically set up during initial configuration of the system.

The phone connection can use one of the following call types:

• Standard Voice: a low-tariff voice connection compressed to 4.0 kbps,

• 3.1 kHz Audio1: a high quality connection used for Premium Voice, G.3 fax 
or analog modem,

• UDI or RDI1 (only on ISDN interface): used for G4 fax or data

• The default setting for an AVIATOR 200/300/350 system is standard voice.

1. AVIATOR 200 with LGA (Class 15): This service is not available.
AVIATOR 300 with IGA (Class 7): The elevation angle must be larger than 45°. 
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In the web interface you can set up which type of connection to use when you 
make or receive a call from the Phone/Fax or ISDN interface or from an IP 
handset connected to the LAN interface.

Example: If you always have a fax connected to the same Phone/Fax 
interface you can set this interface to 3.1 kHz Audio only. This will 
mean that if an incoming Standard Voice call is received, this 
Phone/Fax interface will not ring. For details how to set up the 
interfaces see the AVIATOR 200/300/350 Installation and 
maintenance manual.

When connecting a G4 fax or a modem to the ISDN interface in the system you 
must use UDI.

Selecting the default outgoing call type

This is typically set up during initial configuration of the system.

You can set the default outgoing call type in the web interface. To select the 
default call type for outgoing calls, do as follows:

• For ISDN: Select the call type in the web interface under SETTINGS > ISDN. 
For further information, see the AVIATOR 200/300/350 Installation and 
maintenance manual.

• For Phone/Fax:. Select the call type for each port in the web interface under 
SETTINGS > Phone/Fax. For further information, see the AVIATOR 
200/300/350 Installation and maintenance manual.

Overriding the default outgoing call type

To override the default setting for a specific outgoing call, do as follows:

• To use Standard Voice for the call, dial 1* before the number. 

• To use 3.1 kHz Audio for the call, dial 2* before the number.

Example: To call Thrane & Thrane Inc. in USA that has the country code 1 and 
the phone number 7574639557, forcing the connection to use 

Note Modem or fax: When connecting a fax or a modem to the Phone/Fax 
interface you must use 3.1 kHz Audio.
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Standard Voice, press 1* 00 1 7574639557 followed by # if calling 
from an analog or ISDN phone.

Phone numbers for incoming 3.1 kHz Audio (Premium voice) and 
Standard Voice

The two circuit-switched services 3.1 kHz Audio (Premium voice) and Standard 
Voice have separate phone numbers. This way, a person calling a phone 
connected to the system can select whether to use 3.1 kHz Audio (Premium 
voice) or Standard Voice, simply by using the dedicated mobile phone 
number. The phone numbers are listed in the documentation from your 
service provider. Even though there are two phone numbers to call the 
SwiftBroadband system only supports one circuit-switched call at a time.

If the mobile phone numbers have been entered in the web interface they are 
listed and you can look them up as follows:

1. Access the web interface from a connected computer, open a browser and 
type the address: http://192.168.0.1 (default address). The DASHBOARD 
page is displayed.

2. Select PHONE BOOK > Mobile numbers.

For further information, see Viewing and editing the mobile numbers on 
page 73. If the mobile numbers are not available in the web interface, refer to 
the documentation from your airtime subscription.

For information on how to make a call to the system, see Making a call to the 
system on page 40.

Note This will not change the default call type, only the type used for this 
call.

Note The call type you are using must be selected in the web interface 
(refer to the next section).

Note There are two Voice numbers, one for 3.1 kHz Audio and one for 
Standard voice.
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Selecting the incoming call type

This is typically set-up during initial configuration of the system. 

To select which call types are accepted for an incoming call do as follows:

1. Access the web interface from a connected computer by opening a browser 
and typing the address: http://192.168.0.1. The DASHBOARD page is 
displayed.

2. For ISDN: Select the call type under SETTINGS > ISDN. 
For Phone/Fax: Select the call type for each port under SETTINGS > 
Phone/Fax. 

For further information, see the AVIATOR 200/300/350 Installation and 
maintenance manual.

Making or receiving a phone call

Analog phone, ISDN phone or SIP-enabled IP handset

There are different methods for activating a call, depending on the type of 
phone:

• Analog phone or ISDN phone: Dial the number and press #.

• SIP-enabled IP handset: Dial the number and press the off-hook key.

Making a call

You have different options for making a call:

• Short Dial. If the number you want to call is in the phone book of the 
system, you can use the Short Dial number. You find this number in the 
web interface under PHONE BOOK, first column Entry.
Dial 00 <Short Dial> followed by # or off-hook key.

Example: To call entry number 4 in the phone book, 
dial 004 followed by # or off-hook key.
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• Manual Dial. Dial 00 <country code> <phone number> followed by # or off-
hook key.

Example: To call Thrane & Thrane Inc. in USA that has the country code 1 
and the phone number 7574639557 press 00 1 7574639557 
followed by # if calling from an analog or ISDN phone.

Receiving a call

To be able to receive a call, the phone must be connected to the relevant 
interface of the SBU.

By default, all devices connected to the phone/fax interface, the ISDN interface 
or the WLAN access point will ring when one of the mobile numbers is called. 
Note, however, that this depends on the call type settings made during initial 
configuration of the system. For further details on how to set up the individual 
interfaces see the AVIATOR 200/300/350 Installation and maintenance 
manual and the documentation for your cabin installation. You can see the 
current setting of the interfaces in the web interface, see Accessing the web 
interface in the AVIATOR 200/300/350 system on page 28.

Call log

You can recall information of all incoming, outgoing and missed calls, as well 
as standard and streaming data sessions. This data is stored in the call log of 
the system. To view information on all calls do as follows:

1. Access the web interface from a connected computer, open a browser and 
type the address: http://192.168.0.1 (default). 
The DASHBOARD page is displayed.

2. Click CALLS. For further information, see Using the Call log on page 74.

If power to the system is interrupted, the information on the currently ongoing 
calls (connection time) and data sessions (transferred data) cannot be saved. 
This means that the airtime and bandwidth usage registered in the Call log 
may be slightly inaccurate.
Using a phone or fax machine 39



Chapter 3:  Operating the system

SBLiteUM.book  Page 40  Tuesday, March 13, 2012  1:44 PM
Making a call to the system

To make a call to a phone connected to the system do as follows:

Dial + <Mobile number>

+ is the prefix used in front of the country code for international calls. Mobile 
number: The first part of the mobile number is always 870, which is the prefix 
(“country code”) for the SwiftBroadband system. 

Example: If you are calling from the USA and the mobile number for 
standard voice is 870772420567 on your system, and you want to 
make a call to the system, dial 011 870 772420567.

The phone numbers are listed in the documentation from your service 
provider. If the mobile numbers are listed in the web interface, you can look 
them up as follows:

1. Access the web interface from a connected computer, open a browser and 
type the address: http://192.168.0.1 (default). The DASHBOARD page is 
displayed. 

2. Select PHONE BOOK > Mobile numbers. For further information, see 
Viewing and editing the mobile numbers on page 73.

If the mobile numbers are not available in the web interface, see the 
documentation from your service provider.

Note There are two Voice numbers, one for 3.1 kHz Audio and one for 
Standard Voice.
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Receiving a voice mail message

If a call to the AVIATOR 200/300/350 system is not answered the caller can 
leave a voice mail message with Inmarsat’s voice mail service. Then an SMS is 
sent to the AVIATOR 200/300/350 messaging system to alert you that there is a 
voice message with the contents:

• Number called from

• Date and time the voice mail message has been received

• Number to call to listen to the voice mail message.

To see that a new SMS has arrived you open the web interface. For further 
details see SMS service on page 53 and Viewing the Voice mail number on 
page 76.

On first-time use the voice mail box at Inmarsat’s voice mail service must be 
configured, follow the instructions given when you call the number to listen to 
a voice mail message.

Making local phone calls

You can make local calls between various phones connected to the system. 
Local phone numbers always start with 0. For an overview of the numbers, see 
Special-purpose and local numbers on page 42.

To make a local call do as follows:

Dial <local number> followed by # or off-hook key.

Local numbers of analog phones, ISDN phones and IP handsets are assigned 
according to the table in Special-purpose and local numbers on page 42. Note 
that if you are using local numbers for ISDN and SIP enabled IP devices, the 
numbers must be programmed in the devices. For further information refer to 
the documentation for your device.
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Special-purpose and local numbers

The following list shows the allocated special-purpose numbers.

Number Function

0 * followed by # or off-hook key Re-dial last called number on this interface.

00 * followed by # or off-hook key Re-dial last answered call on this interface.
Note: If the last answered number is an 
unlisted number, you will not be allowed to 
dial back.

00 followed by one of the numbers 
1-199 and # or off-hook key

Short dial phone numbers in phone book.

0300 followed by # or off-hook key Local call broadcast to both analog phones.

0 followed by one of the numbers 
301-302 and # or off-hook key 

Local call to analog phone. 

0400 followed by # or off-hook key Local call broadcast to all ISDN phones.a

a. Note that the local number must be programmed in the ISDN and SIP-enabled IP 
phone.

0 followed by one of the numbers 
401-402 and # or off-hook key

Local call to ISDN phone.a

0500 followed by # or off-hook key Local call broadcast to all IP handsets.a

0 followed by one of the numbers 
501-516 and # or off-hook key

Local call to SIP-enabled IP handset.a

0900 followed by # or off-hook key Local call broadcast to all handsets.
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Dialing prefixes

Apart from the numbers above, you can use the following dialing prefixes 
before the number:

Prefix Function

1* Forces the connection to use Standard Voice.

2* Forces the connection to use 3.1 kHz Audio.

#31# Hides the caller’s phone number to the recipient.

*31# Shows the caller’s phone number to the recipient where 
it would otherwise be hidden, e.g. because the number is 
an ex-directory number.

R The following key-presses should activate a 
supplementary services function supported by the 
system. These function are described in the following 
sections.
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Handling waiting calls

During a local or external call, if a second party attempts to make contact with 
you, you may hear a Call Waiting indication. This indication is two beeps and a 
pause of 3 seconds, then two beeps again etc. If no action is taken, the waiting 
call is released after a time-out period.

In the web interface you can enable or disable the call waiting indication. For 
further information how to set-up the call waiting function see the AVIATOR 
200/300/350 Installation and maintenance manual.

How to handle waiting calls depends on the type of phone. For analog 2-wire 
phones with an R key follow the instructions in the table below.

For information how to handle waiting calls using the AVIATOR Wireless 
Handset see the user manual of the AVIATOR Wireless Handset.

If you want to: Do as follows:

Clear the current call, and 
accept the waiting call.

Press R 1 #, within the time-out period.

Hold the current call, and 
accept the waiting call.

Press R 2 #, within the time-out period.

Ignore the waiting call. Take no action.

Reject the waiting call. Press R 0 #, within the time-out period.

Note The SwiftBroadband system only supports one circuit-switched call 
at a time per AVIATOR 200/300/350 system.
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Holding a call

During a local or external call, you may place the initial call on hold while 
another call is made. 

How to put a call on hold depends on the type of phone. For analog 2-wire 
phones with an R key follow the instructions in the table below.

For information how to hold a call using the AVIATOR Wireless Handset see 
the user manual of the AVIATOR Wireless Handset.

If you want to: Do as follows:

Place a call on hold. Press R 2 #.

Place the existing call on 
hold and establish a new call.

Press R and dial the second phone number 
followed by #.

Shuttle between the two 
calls.

Press R 2 #
(irrespective of whether the second call was 
acquired using Call Hold or acceptance of 
Call Waiting.)

Clear the held call, if no 
waiting call exists.

Press R 0 #.

Clear an active call and 
return to the held call.

Press R 1 #. 
Note that this is only possible if no waiting 
call exists.

Note The SwiftBroadband system only supports one circuit-switched call 
at a time per AVIATOR 200/300/350 system.
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Transferring a call

When you receive a call, you can transfer this call to another phone connected 
to the system.

How to transfer the incoming call to another phone or headset depends on the 
type of phone. For analog 2-wire phones with an R key follow the instructions 
listed below.

1. Press R 4 * <local number> #.
The phone with the local number you dialed starts to ring. 

2. You now have two options.

• Hang up. The phone or headset you transferred the call to continues to 
ring. When the call is answered, a connection is established between 
the initial caller and the new recipient.

• Do not hang up. When the new recipient answers, you can have a 
conversation before hanging up. When you hang up, the call is handed 
over to the initial caller.

For information how to transfer a call using the AVIATOR Wireless Handset see 
the user manual of the AVIATOR Wireless Handset.

To make a multi-party call

How to make a multi-party call depends on the type of phone. For analog 2-
wire phones with an R key follow the instructions listed below.

Note The SwiftBroadband system only supports one circuit-switched call 
at a time per AVIATOR 200/300/350 system.
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When you have an already established call you can initiate a conference call 
by using the following options: 

For information how to make a multi-party call using the AVIATOR Wireless 
Handset see the user manual of the AVIATOR Wireless Handset.

Forwarding a call

You can set up the system to automatically forward incoming calls to another 
phone number. This information is saved in the SwiftBroadband network so it 
is available when the call cannot be put through and must be forwarded. This 
service is usually setup by the airtime provider.

If you want to: Do as follows:

Add an incoming 
call announced by 
the Call Waiting 
indication.

Press R 2 #, the already established call is put on hold 
and the incoming call is connected for you to have an 
initial conversation with the caller before the call is 
added to the conference call.

Then press R 3 #, you are returned to the held calls 
and the incoming call is joined in the conference call.

Initiate a new call 
and have it joined 
to the already 
existing call.

Press R <phone number> #, to initiate a new call and 
have an initial conversation before the call is added to 
the conference call.

Then press R 3 #, you are returned to the held calls 
and the initiated call is joined in the conference call.

Clear all calls. Press R 1 # or alternatively just hang-up.
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To forward incoming calls do as follows:

1. Select SETTINGS > Common > Call forward from the left navigation pane.

2. Click OK next to Read current settings to display the phone numbers for call 
forwarding for the subscription or what you have entered. These numbers 
are operator controlled and come with your airtime subscription (default). 
A message saying Operation in progress, please wait. is displayed.

3. For each call type, select Enabled next to the situation(s) in which you want 
to forward incoming calls.

4. Next to the enabled items, you can type in a phone number to forward the 
call to. If you have selected Forward if no reply, select from the drop-down 
list the period of time the system should wait before forwarding the call.

5. Click Apply.

Figure 3-1: 

Note Allow sufficient time for the system to read the current settings 
over the satellite connection.
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Sending or receiving a fax message

Delay before time-out

When sending or receiving fax messages over a satellite connection, the fax 
units at each end of the transmission line must be capable of handling longer 
delays without timing out. Some fax machines have an Overseas mode, which 
enables the unit to handle the long delays. Make sure that your fax machine is 
set to allow long delays before time-out.

Sending a fax message from the system

The fax machine must be connected to the Phone/Fax interface or the ISDN 
interface of the system. See the AVIATOR 200/300/350 Installation and 
maintenance manual for further details.

3.1 kHz Audio must be used for an analog fax machine. See Selecting the 
default outgoing call type on page 36.

UDI must be used for an ISDN G4 fax machine, refer to the AVIATOR 
200/300/350 Installation and maintenance manual for details how to 
configure the ISDN interface. 

To send a fax from a fax machine connected to the system, dial 
00 <country code> <phone number> #

Example: To send a fax to Thrane & Thrane Inc. in the USA (the number +1 
757 463 9581), dial 00 1 757 463 9581 #

Note Only AVIATOR 300 and AVIATOR 350.

Note In case the default setting in the web interface is not 3.1 kHz Audio, 
dial 2 * before the number, to force the connection to use 3.1 kHz 
Audio for fax use. For further information, see Overriding the default 
outgoing call type on page 36.
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Sending a fax message to the system

To send a fax message to the system, dial

+ <Mobile number> #

• + is the prefix used in front of the country code for international calls.

• Mobile number. The first part of the mobile number is always 870, which is 
the “country code” for the SwiftBroadband system. 
To send a fax to a G3 fax use the 3.1 kHz Audio mobile number 
To send a fax to an ISDN G4 fax use the UDI number.
The numbers are listed in the documentation from your service provider. If 
the mobile numbers are listed in the web interface, you can look them up 
as follows:
Connect a computer, access the web interface and select PHONE BOOK > 
Mobile numbers. For further information, see Viewing and editing the 
mobile numbers on page 73.

Receiving a fax message

An analog fax machine connected to the system can only receive a fax with 
3.1 kHz Audio. Refer to Selecting the incoming call type on page 38.

An ISDN G4 fax machine connected to the AVIATOR 200/300/350 system can 
only receive a fax with a call type UDI.

Note There are four mobile numbers, one for 3.1 kHz Audio, one for 
Standard voice, one for UDI and one for RDI.
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Using a SIP-enabled IP handset or smartphone

SIP-enabled wireless IP handset or smartphone

The AVIATOR 200/300/350 system has in integrated SIP server. If your mobile 
phone or smartphone is a SIP enabled IP handset, it has a SIP client. Then you 
can set it up and use it to make phone calls or use other data services using 
the SwiftBroadband service.

Once set-up, you can use the SIP-enabled IP handset as a local phone during 
flight. When calling you use the SwiftBroadband service and the 
SwiftBroadband mobile numbers. The call costs will be charged to the 
SwiftBroadband subscriber. The call receiver will be called up from the 
system’s 870 number (Area code for Inmarsat satcom services).

When your device is connected to the SIP server of the AVIATOR 200/300/350 
system you cannot be called at your own mobile number and you cannot send 
or receive SMS messages.

Where to get a SIP client application

If your smartphone does not have a SIP client, you can download one from 
one of the links below: 

• Apple iPhone App store (www.apple.com/iphone/from-the-app-store/)

• Android Market (www.android.com/market/)

Note Check whether your mobile phone or PDA has a wireless interface 
and an integrated SIP client.

Note The SIP client is a third party application. Thrane & Thrane dose not 
offer technical support for it.
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Setting up a SIP-enabled wireless IP handset

To set up a SIP enabled IP handset, do as follows:

1. Connect to the Wireless access point of the AVIATOR 200/300/350 system. 
Check that the WLAN icon in the handset display indicates that the WLAN 
connection has been established. If your WLAN is encrypted check with 
your system administrator how to proceed to access the encrypted WLAN 
network.

2. Connect to the SIP server of the AVIATOR 200/300/350 system. See the user 
manual of your IP handset for guidelines how to establish a connection to 
a SIP server.
For this you need to enter the following details into the device:

• SIP server name, port and address, default: 192.168.0.1

• User name

• Password

• Codec priority

• Realm

User name: When connecting to a SwiftBroadband Unit, the user name should 
be a local number, i.e. 05xx. This must be configured in the built-in web 
interface under SETTINGS > IP handsets.

Password: When connecting to a SwiftBroadband Unit, the password is the 
local number for this phone. It is a number in the range of 0501 to 0516 which 
is not yet assigned to other IP phones. The password must match the IP 
Handset password entered in the SwiftBroadband Unit.

Codec priority: Select the codec type that should have the highest priority. You 
may select G.711 A-LAW.

Realm: If asked for Realm, enter the serial number of the AVIATOR 
200/300/350 SBU.
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Having established this connection you can make calls with SIP-enabled IP 
handset and it can be called to, also as a local phone of the AVIATOR 
200/300/350system.

SMS service

Introduction

The integrated SMS service lets you send and receive short text messages from 
and to the AVIATOR 200/300/350 system. Theses messages are public and 
stored in the system, they can be viewed by all system users. The SMS service 
is used to alert you that a voice mail has been received.

The AVIATOR 200/300/350 message service does not manage personal SMS 
messages to and from personal IP devices. 

Sending an SMS message

You can send and receive SMS messages using the AVIATOR 200/300/350 
system. To do this you must connect a computer to the system using a LAN or 
WLAN connection and access the web interface.

To send an SMS message from the system, do as follows:

1. Access the web interface from a connected computer, open a browser and 
type the address: http://192.168.0.1 (default). The DASHBOARD page is 
displayed. 

2. Click MESSAGES from the left navigation pane.
This page contains new incoming messages. On this page you can archive 
the messages and move them to the Inbox or you can delete a message.

Note All charges for calls and data sessions are billed to the AVIATOR 
200/300/350 system. 
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3. In the left navigation pane, click Write message.

4. Type in the message in the Write new message field.
If the message text is too long for one SMS, the message is sent as two or 
more SMS messages. The field below the message field shows the number 
of SMS messages used to send the message.

5. Type in the phone number in the Recipient field. 
Remember 00 or + and country code (e.g. 00 45 for Denmark or 00 1 for 
USA).

6. Select whether or not you want Delivery notification for this SMS message. 
If you click Yes, the Status column in the Sent folder will show the status of 
your message when it has been sent.
You can set up delivery notification generally for all SMS messages. This 
setting is used by default when you send a message. For further 
information, see Configuring message settings on page 59.

7. Click Send.
The message is now sent and moved to the Sent folder. 
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One SMS messages can have 160 characters. However, the system will allow 
you to input a longer message, which will then be divided up and sent as 
multiple SMS text messages. Have this in mind when you write messages. The 
more messages you have to send, the more transferred data you are charged 
for. 

Options for messages in the Outbox

Messages in the Outbox are messages that have not been sent, e.g. because 
the system was not online when you attempted to send the messages.

To access the Outbox, click MESSAGES > Outbox from the navigation pane.

You have the following options for messages in the Outbox:

• When the system is online, click Resend next to the message you want to 
send. When the Write message page opens, click Send.
The system now attempts to send the message again. To make sure the 
message has been sent, look in the Sent folder.

• Click Delete next to a message to delete it.

• Click Delete all messages in Outbox to delete all the messages.

Important If the system is not online when you attempt to send a 
message, the message is moved to the Outbox instead of the 
Sent folder. Messages in the Outbox are not automatically sent 
when the system goes online. For further information on the 
Outbox, see the next section, Options for messages in the 
Outbox. To make sure a message has been sent, check that it 
has been moved to the Sent folder.

Note The original message remains in the Outbox. When you have 
succeeded in sending the message you may want to delete it 
from the Outbox.
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Options for messages in the Sent folder

The Sent folder contains SMS messages that have been sent.

To access the Sent folder, select MESSAGES > Sent from the navigation pane. 

The Status column shows the status of each message, if you have selected 
Delivery notification when sending the message.

From the Sent folder you have the following options:

• Click Resend next to a message you want to send again. 
When the Write message page opens, click Send.
The system now attempts to send the message again. To make sure the 
message has been sent, look in the Sent folder. There should now be two 
copies of the sent message.

• Click Forward next to a message you want to forward. 
Type in the phone number of the new recipient and click Send.
The system now attempts to send the message to the new recipient. To 
make sure the message has been sent, look in the Sent folder.

• Click Delete next to a message to delete it.

• Click Delete all sent messages to delete all the messages.

Sending an SMS message to the system

You can send an SMS message to the system e.g. from a mobile phone, using 
one of the system’s mobile numbers for voice. Dial

+ <Mobile number>

The first part of the mobile number is always 870, which is the “country code” 
for the SwiftBroadband system. If the mobile numbers are listed in the web 
interface, you can look them up as follows: 

Select PHONE BOOK > Mobile numbers. If the mobile numbers are not listed in 
the web interface, refer to your service provider.

Note There are two Voice numbers, one for 3.1 kHz Audio and one for 
Standard Voice.
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Receiving a message

If a message has arrived, the icon bar at the top of the web interface shows an 
unopened envelope. Click the envelope to see the new message(s).

Otherwise, to see new messages click MESSAGES from the left navigation 
pane. The page shows new incoming messages.

The message icon disappears when all the messages on this page have been 
archived or deleted.

If the message is not an SMS message but information of voice mail, call your 
voice mail service number to hear the voice mail. The voice mail number is 
displayed together with the message.

When using the voice mail service for the first time you must configure your 
voice mailbox with your welcome greetings. Follow the instructions given by 
the voice mail system.

To find your voice mail number, select MESSAGES > Message settings from the 
left navigation pane and locate the Voice mail number. 

Note that the voice mail number is only shown if it is available on the SIM 
card. Otherwise, refer to the information from your service provider.

Note The system does not accept more than 100 incoming messages 
(including read and unread messages). If you have received 100 
messages, you have to delete some of them in order to free space 
for new messages. Otherwise, the new messages are rejected.
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Options for new SMS messages

To see new messages, click MESSAGES from the left navigation pane. 

Besides viewing the new messages, you have a number of options for what to 
do with each message:

• Click Read to move it to your Inbox containing read messages.

• Click Reply to reply to a message. 
Then type in your reply and click Send.
For information on how to include the original message in your reply, see 
Setting up the default message options on page 59.

• Click Forward to forward a message to someone. 
Then type in the phone number in the Recipient field and click Send.

• If you want to move all the new messages, click Move all new messages to 
Inbox.

Options for SMS messages in the Inbox

The messages in the Inbox are the incoming messages that have been 
archives from the list of new messages.

From the Inbox, you have the following options:

• Click Reply to reply to a message. 
Then type in your reply and click Send.
For information on how to include the original message in your reply, see 
Setting up the default message options on page 59.

• Click Forward to forward a message to someone. 
Then type in the phone number in the Recipient field and click Send.

• Click Delete to delete the message. 

• Click Delete all messages in Inbox to delete all read messages in the Inbox. 

Note New messages cannot be deleted until they have been archived 
and moved to the Inbox.
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Configuring message settings

Setting up the default message options

You can set up general options for outgoing messages. These settings apply 
by default to all outgoing messages. Note, however, that you can change the 
Delivery notification setting for an individual message. For further 
information, see Sending an SMS message on page 53.

To set-up the default message options do as follows:

1. Select MESSAGES > Message settings from the left navigation pane.

2. If you want to include the original message when you reply, select Yes next 
to Include message in reply.

3. Select whether or not you want Delivery notification for SMS messages. 
If you click Yes, the Status column in the Sent folder will show the status of 
your message when it has been sent.

4. Click Apply.
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Viewing or changing SMS service center number

The SMS service center number identifies the SMS service center used when 
sending and receiving SMS messages. The SMS service center is used when 
you send a text message (SMS message) to another user. The message is 
stored in the SMS service center which delivers it to the destination user when 
they are available. 

The SMS service center number is stored on the SIM card.

• To see the SMS service center number, select 
MESSAGES > Message settings from the left navigation pane.

• To change the number, click Edit next to SMS service center, change the 
number and click Save. Then click Apply to apply all changes in the page.

The SMS service center number is provided from your service provider.
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Advanced use 4

In this chapter

In this chapter you can read about:

• Getting to know the web interface

• Using the phone book and Viewing the Voice mail number

• Start or stop any data session

• Preferred satellite

• Call log handling

• Setting data limits

• Setting up the local exchange function

• Remote management

• Remote activation with SMS

• Restricted dialing
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Getting to know the web interface

The web interface is built into the system and 
used for operating, setting up and configuring 
the system. 

You can access the web interface from a 
computer with a standard Internet browser.

Connecting to the web interface

To access the web interface, an Internet browser must be installed on the 
computer. Connect your computer to the AVIATOR 200/300/350 system, using 
one of the LAN interfaces (up to 6) installed in the aircraft cabin or use the 
Wireless connection, if available.

Proxy server settings

If you are connecting your computer using a LAN or WLAN interface, the Proxy 
server settings in your browser must be disabled before accessing the web 
interface. Most browsers support disabling of the Proxy server settings for one 
specific IP address, so you can disable Proxy server settings for the web 
interface only, if you wish. Consult your browser help for information.
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To disable the use of a Proxy server completely, do as follows:

1. In Microsoft Internet Explorer, select Tools > Internet Options > Connections 
> LAN Settings.

2. Clear the box labeled Use a proxy server for your LAN. 

3. Click OK.

When the proxy server settings are disabled, close and restart your browser.

You may need to change this setting back on return to your Internet 
connection.

Note The following description is for Microsoft Internet Explorer. If you 
are using a different browser, the procedure may be different.
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IP address and DNS server address setup 

To check whether automatic IP address and DNS server address is obtained 
automatically for your computer, do as follows (example for Windows XP):

1. Go to Start > Settings > Control Panel > Network Connections.

2. Right-click on the LAN connection you want to use.

3. Select Properties, highlight Internet Protocol (TCP/IP).

4. Click Properties. 

5. Make sure that the following is selected:
- Obtain an IP address automatically
- Obtain DNS server address automatically

Allocating IP addresses and DNS server lookups are handled by the system. 
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Accessing and navigating the web interface

Accessing the web interface

To access the web interface, do as follows:

1. Connect your computer to the system.

2. Make sure that the AVIATOR 200/300/350 system is fully operational in the 
aircraft.

3. Open your Internet browser and enter the IP address of the system. This is 
the internal IP address. The default IP address is 192.168.0.1.

Note If the IP address has been changed and you do not have the new 
address, contact your system administrator and request the new IP 
address.
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Overview of the web interface

The web interface consists of the following sections (example: AVIATOR 350):

• The navigation pane holds the main menu. Clicking an item in the menu 
opens a submenu in the navigation pane or a new page in the contents 
section.

• The status field shows the signal strength.

• The icon bar shows icons for new SMS messages and for active events, 
when relevant. For explanations of the icons, see the next section, Icons in 
the icon bar.

• The contents section shows the page selected in the navigation pane. This 
section is used for viewing or changing settings, or for performing actions.

Contents sectionStatus field Icon bar

Navigation pane
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Icons in the icon bar

The following icons may appear in the icon bar in the web interface:

Navigating the web interface

• To expand a menu, click the menu in the navigation pane. 

• To access status and settings, click the relevant subject in the navigation 
pane or click the relevant icon in the icon bar. The status or settings are 
displayed in the contents section.

• To get an overview over the submenus available use the site map, click 
SITE MAP in the navigation pane. Click on items in the site map to go 
directly to the relevant location.

Icon Explanation

A new SMS message, or information of Voice mail, has arrived. 
Click the icon to see new messages or information of Voice mail. 
For further information, see Receiving a message on page 57.

An event is active. Click the icon to see a list of active events. For 
explanations of the event messages, see the AVIATOR 
200/300/350 Installation and maintenance manual. Note that this 
icon will remain in the icon bar as long as the event is still active.

Note Some parts of the web interface may be greyed out if the user 
permissions are limited. For information on how to set up user 
permissions, see the AVIATOR 200/300/350 Installation and 
maintenance manual.
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Using the Dashboard

The Dashboard is the first screen that is displayed when you enter the IP 
address of the web interface of the AVIATOR 200/300/350 system. The 
Dashboard is used for control and inspection of ongoing communication and 
for viewing properties and status of the system and antenna.
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Properties

The PROPERTIES section of the DASHBOARD shows the following information:

• Airtime provider. The name of your Airtime Provider.

• GPS position. The GPS position of your AVIATOR 200/300/350 system.

• Status. The status of the system and antenna.
Examples of status information are: Scanning, Ready and Data active.

• Satellite selection. The satellite selected for logon. For further information, 
see Selecting the preferred satellite on page 78.

• Current satellite. The current satellite and elevation angle.

• Unit serial number. The serial number of the SwiftBroadband Unit of the 
AVIATOR 200/300/350 system.

• Software version. The version of the software embedded in the 
SwiftBroadband Unit.

• Certification level. This field shows whether the system is Level-D or Level-
E certified.

• IMSI number. The IMSI number (International Mobile Subscriber Identity) 
of the system. It is a unique number that is stored on the SIM card inside 
the system and sent to the network.

• IMEI number. The IMEI number (International Mobile Equipment Identity) 
of the system. This is a unique number that identifies your system.

Note In some cases, the BGAN network does not allow the position to 
be displayed to the user. If this is the case, the display may just 
show GPS acquired. This means that the GPS position is received, 
but the user is not allowed to see it.

This also applies if the AVIATOR 200/300/350 is not yet 
registered on the SwiftBroadband network, but the GPS position 
is received.
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Viewing information on calls and data sessions

The following sections in the Dashboard show information on calls and data 
sessions.

• ONGOING DATA SESSIONS is a list of data profiles that are currently active, 
including the external IP address that is assigned to each profile. The 
external IP address is assigned by the SwiftBroadband network for each 
connection.

• SESSIONS TOTAL lists the totals for each connection type. The list shows the 
time connected for voice and Streaming data, and MB transferred for 
Standard data.

• ONGOING CALLS is a list of calls that are currently active. The list shows the 
call type and the time connected for each call.

The counters show totals for connections since the counters were last cleared. 
For information on how to clear the counters, see Call log handling on 
page 80.
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Using the phone book

The phone book is stored in the Configuration module of the AVIATOR 
200/300/350 system. In the phone book you can:

• Look up phone numbers.

• Look up short-dial numbers for easy dialing from a handset. 

• Modify or delete existing names and phone numbers, or add new names 
and phone numbers.

The numbers of the phones available on the aircraft and the mobile number of 
the system might already be entered when the system was initially configured.

Accessing the phone book

To access the phone book, select PHONE BOOK from the left navigation pane.

The phone book shows all entries with entry number, name and phone 
number. Empty placeholders are also included.

To sort the phone book, click the title of the column you wish to sort by. For 
example, to sort by the names in the phone book alphabetically, click on Name 
in the top row of the phone book.

The phone book holds 199 entries divided into sub pages. To select the sub 
pages you want, click the relevant link at the bottom of the page.
Using the phone book 71



Chapter 4:  Advanced use

SBLiteUM.book  Page 72  Tuesday, March 13, 2012  1:44 PM
Short dial

The entry number in the phone book is the Short dial number. When making a 
call from the system you can use this number instead of dialing the entire 
phone number.

Dial 00 <short dial> followed by # or off-hook key.

Example: To call the third entry in the phone book from an analog phone, 
take the phone off hook and dial 003 #.

Adding, modifying and deleting phone book entries

To add a new entry, do as follows:

1. In the phone book, locate the empty entry number where you want to add 
the new phone number and click New.

2. Type in the name and phone number of the new entry and click Save entry.
The new name and number are now listed at the specified entry number in 
the phone book.

To modify an entry, do as follows:

1. In the phone book, click Edit next to the entry you want to modify.

2. Modify the name or number as wanted and click Save entry.
The name and/or number in the selected entry is now replaced with the 
new information.

To delete entries, do as follows:

To delete one entry, click Delete next to the entry you want to delete.

To delete all the entries in the phone book, click Delete all entries in phone 
book at the bottom of the PHONE BOOK page.
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Viewing and editing the mobile numbers

To view the mobile numbers

To view the mobile numbers of the AVIATOR 200/300/350 system, select 
PHONE BOOK > Mobile numbers from the left navigation pane. The mobile 
numbers are the phone numbers to use when making a call to the AVIATOR 
200/300/350 system.

To enter or edit the mobile numbers

To enter or edit the mobile numbers, click Edit at the bottom of the page, type 
in the numbers received from your service and airtime provider and click OK.

Note These numbers are not listed at delivery. They may have been 
entered during initial configuration of the system or can be entered 
at a later stage. The numbers are stated in the documentation from 
the service and airtime provider.
Using the phone book 73



Chapter 4:  Advanced use

SBLiteUM.book  Page 74  Tuesday, March 13, 2012  1:44 PM
Using the Call log

The call log holds information on all calls and data sessions since the call log 
was last cleared. 

Information on total usage

To enter the CALLS page select CALLS from the left navigation pane. The CALLS 
page contains information on usage for circuit switched connections.

The listed information includes:

• Time connected using Standard Voice

• Time connected using 3.1 kHz Audio.

Note If power to the system is interrupted, the information on the 
currently ongoing calls (connection time) and data sessions 
(transferred data) cannot be saved. This could mean that the airtime 
and bandwidth usage in the Call log will be slightly inaccurate. 

Figure 4-1: 
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Exporting the call log

You can export the call log file for archiving, surveillance or other tracking 
purposes. To export the entire call log to a file, do as follows (example for MS 
Internet Explorer):

1. In the CALLS page, click the link Export call log to file. The log opens in the 
current browser window. 

2. In the browser, click File, Save as.

3. Browse to the location where you want to save the log. The log is saved as 
a.txt file.

4. Click OK.

5. Click Back to return to the web interface.

If there are more than 100 calls in the total list, the oldest calls are 
automatically removed to make room for new calls.

Viewing the lists of calls and data sessions

To see information on outgoing, received or missed calls or data sessions, 
select one of the following submenus from the left navigation pane in the 
CALLS page:

• Outgoing calls shows the start time, receiving end phone number, duration, 
type (Standard or 3.1 kHz Audio) and estimated charge of each outgoing 
call. 

• Received calls shows the start time, calling phone number, duration and 
type (Standard or 3.1 kHz Audio) of each incoming call.

• Missed calls shows the start time, calling phone number and type 
(Standard or 3.1 kHz Audio) of each incoming call that was not received.

• Standard data sessions shows the start time, bytes in, bytes out and 
estimated charge of each Standard IP session.

• Streaming data sessions shows the start time, duration, type (Streaming 8, 
16, 32, 64, 128 kbps or X-Stream) and estimated charge of each Streaming 
IP session.
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Date and time is the international UTC time, received from the satellite. 

For information on the available types of service, see the AVIATOR 
200/300/350 User Manual.

You can sort each of the lists by clicking the title of the column you wish to sort 
by. 

If a list covers more than one page, you can click the relevant link at the 
bottom of the page, to go to another page.

Viewing the Voice mail number

The Voice mail number is the number you call to hear your incoming voice 
mail.

To see the Voice mail number, select
MESSAGES > Message settings from the left navigation pane. The Voice mail 
number field shows the Voice mail number.

Note The estimated charge is based on your entries under 
ADMINISTRATION > Call charges. Thrane & Thrane does not take 
responsibility for the correctness of the estimated charges. This 
calculation is only a rough estimate of the charge, based on the 
tariff entered by the user. Also, the airtime provider may have 
different methods of calculating the charge.

Note The Voice mail number is only listed if it is available on the SIM 
card. Otherwise, refer to the information included with your airtime 
subscription.
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Start or stop any data session

If necessary, you can start and stop any data session for all network user 
groups connected to the system. To use this feature you must login as an 
administrator.

To start or stop any data session, do as follows:

1. Select CONNECT.
If you are not yet logged in as an administrator, enter the administrator 
user name and password. The default user name is admin and the default 
password is 1234. If the password has been changed, contact your system 
administrator. 
Under ONGOING DATA SESSIONS at the top you can see which data 
sessions are currently active and which are allowed. 
Example:

In the example above you could manually start the streaming 128 
connection of the GROUP 0 and stop the standard connection of the 
DEFAULT GROUP.

2. Click on the session you want to start or stop.
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Preferred satellite

By default the system is set up to automatically find the most appropriate 
satellite to connect to (“Auto” mode). However, if you are located in an area 
with more than one satellite available, you can select the satellite you prefer 
to use when registering on the SwiftBroadband network.

To see the areas covered by the I4 satellites see SwiftBroadband coverage on 
page 9.

Selecting the preferred satellite

To select the preferred satellite, do as follows:

1. Select SETTINGS from the left navigation pane.

2. Select the satellite you prefer to use. 
If you select Auto (default setting) the AVIATOR 200/300/350 system 
automatically uses the most appropriate satellite. 

Important If you have any ongoing calls or data sessions and you 
decide to change over to another satellite, the calls or data 
sessions will be terminated when you click Apply!
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3. Click Apply.
The AVIATOR 200/300/350 terminates all ongoing connections and de-
registers from the current satellite before registering on the new satellite.

Note If you have selected a satellite, your AVIATOR 200/300/350 system 
will only try to establish a connection to the selected satellite. This 
means that if the antenna is outside the coverage area for that 
satellite, the AVIATOR 200/300/350 system will not be able to 
register with the SwiftBroadband network.
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Call log handling

To clear the logs of the system and/or reset the counters for the time 
connected, do as follows:

1. From the left navigation pane in the ADMINISTRATION page, select Log 
Handling.

2. To clear the Call log, click OK next to Clear call log?. 

3. To clear the total counters, click OK next to Clear total counters?. 
This resets the Time connected counters on the Calls page.
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Setting data limits

You can set a limit for the use of data services with the AVIATOR 200/300/350 
system. You either specify a maximum number of MB for the standard data 
connection, and/or a time interval from start to end for a streaming 
connection.

If you have entered the call charges in the menu Call charges, the system 
automatically calculates and displays the maximum charges for your data 
sessions.

Once the entered limit is reached, the connection is automatically stopped. 
This is recorded in the menu CALL containing a call log in which you can see 
information on standard and streaming data sessions. To continue using the 
data services you must start a new connection by clicking on the desired 
connection on the Dashboard.

To set data limits, do as follows:

4. From the left navigation pane in the ADMINISTRATION page, select Data 
limits.

5. Select the services to close automatically after a fixed amount of data or 
period of time.
For Standard data type in the number of mega bytes (MB) allowed. 
For streaming classes select a period of time from the drop down list.

6. Click  Apply to save the settings.

Note Thrane & Thrane does not take responsibility for the correctness of 
the estimated charges. This calculation is only a rough estimate of 
the charge, based on the tariff entered by the user. Also, the airtime 
provider may have different methods of calculating the charge.

Note If you set a data limit for the Standard data connection, automatic 
activation of the Standard data connections is disabled for all 
network user groups.
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Setting up the local exchange function

If you want to call a specific phone connected to the terminal, use the local 
exchange function. With this function enabled, when you dial the mobile 
number of the terminal, a recorded message instructs you to dial the number 
for the local phone you want to call. Your call is then transferred to the 
requested phone and only the requested phone rings.

If the local exchange is not used (Incoming calls not selected), incoming calls 
will per default cause all connected phones to ring.

To set up the local exchange, do as follows:

1. Select SETTINGS > Common > Local exchange from the left navigation 
pane.

2. Type in the local number to which incoming calls are transferred to if the 
caller dials * after calling the mobile number, or the caller dials nothing 
after the recorded message.

3. Select the call types you want to direct to the local exchange. 
If you use 3.1 kHz Audio for a fax machine only, do not select 3.1 kHz Audio 
as this line is used for the fax. 
If no call type is selected, the local exchange function is disabled (default 
setting).

4. Click Apply.

Figure 4-2: 
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Remote management

Preparing the AVIATOR 200/300/350 for remote 
management

1. Verify that the AVIATOR 200/300/350 is correctly set up for this feature. 
How to set up this feature is described in the Installation and Maintenance 
Manual.

2. Activate a data connection in one of the following ways:

• Remote activation with SMS.

• Automatic activation of a data connection (not remote).

• Manual activation of a data connection (not remote).

3. Note the system’s external IP address, found in one of the following ways: 

• Unmanned SMS activation: You will receive an SMS with the IP address 
when the system is powered up and operational.

• Connect a computer locally to the system and start the web interface. 
The IP address of the system is shown in the Dashboard under 
ONGOING DATA SESSIONS (in parenthesis).

This is the IP address you must use to access the system remotely.
If Static IP address is included in your airtime subscription, we recommend 
using this IP address for the system in order to provide easy access to the 
system.

Accessing the AVIATOR 200/300/350 from a remote location

To access the SBU from a remote location, do as follows:

1. On the remote computer, open a web browser.

Note You can remotely control the SBU. Some setup tasks must be done 
before being able to use the remote function. These tasks are 
described in the following sections.
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2. Enter the IP address of the SBU followed by colon and the port number 
http://<ip address>:<incoming port>.

• <ip address> is the address from step 3 above.

• <incoming port> is the port that has been defined during system 
installation.

Example: If the IP address of the SBU is 161.30.180.12 and the incoming 
port number defined in the Remote management page in the 
web interface is 8080, enter http://161.30.180.12:8080.

You are now connected to the SBU from the remote computer.

Note Contact your installation center for further information on the 
SBU IP address and port number. Your system may have a static 
IP address that is assigned each time when the SBU logs on.
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Remote activation with SMS

If you want to remotely control the system, it must have activated a 
connection. You can do this by sending an SMS to the system. The system 
must be powered up and logged on to the satellite services to receive the SMS 
and then start the connection. The SMS activation is always protected by a 
password. You can set up the system to send an SMS confirmation on the 
status of the connection, whether it is activated successfully or the activation 
failed.

To set-up the system for remote activation with SMS, do as follows:

1. From the left navigation pane, select ADMINISTRATION > Remote 
activation.

Note The system must be logged on to the satellite services to receive 
and accept an activation SMS. If the SMS is considered too old 
or sent before the system has been switched on and has logged 
on, the SMS will be ignored.

Important This service is available if the service provider has an 
interoperability agreement with Inmarsat and allows for 
roaming. If in doubt, contact your mobile provider. 

Figure 4-3: 
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2. Select whether remote activation should be Enabled or Disabled.

3. Select whether confirmation by SMS should be Enabled or Disabled.

4. Enter the password. It can be up to 32 characters long. The characters 0-9, 
a-z and A-Z are allowed. The password is mandatory and must match the 
password in the activation SMS.

5. Enter at least one trusted mobile number from which the system accepts an 
activation SMS. If no numbers are entered the feature is disabled 
automatically. Use the wild card * to accept a range of trusted numbers.

6. Click Apply to save the new settings.

SMS format

The activation SMS must have the following format for activating and 
deactivating a connection in the SBU:

• ACTIVATE <name of network user group>:<name of profile> 
<password>

• DEACTIVATE <name of network user group>:<name of profile> 
<password>

The password is case sensitive, the words ACTIVATE and DEACTIVATE are not.

Examples for SMS

• Open a Standard data connection in the Default network user group:
ACTIVATE default group:standard 1234567890

• Close a Streaming 32 connection in the network user group Group 0:
DEACTIVATE Group 0:streaming 32 1234567890

Note that one profile is allowed per SMS.

Mobile number with wild card Mobile numbers accepted

00453955880* 004539558800 to 004539558809

0045395588* 004539558800 to 004539558899
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Restricted dialing

In order to manage the use of the system efficiently you can set up the system 
to limit all calls to allowed numbers or numbers in the phone book. This 
feature can be enabled for each connected handset separately. Each handset 
has its own local number.

To setup the  system for restricted dialing, do as follows:

1. From the left navigation pane, select ADMINISTRATION > Restricted 
dialing.

2. Select whether restricted dialing should be Enabled or Disabled.

3. Type in the allowed numbers or masks in the entry fields.
The numbers or masks must be max. 32 digits and may start with +. No 
other special characters are allowed. A mask is the first part of a phone 
number, and it covers all numbers that start with that first part. See the 
example below.

4. Select whether outgoing calls should be limited to the numbers in the 
terminal phone book (Enabled) or not (Disabled).

5. Check which local numbers are available in your system. Then select for 
which local numbers you want to enable the restriction.

6. Click Apply to apply the new settings.

Mask Numbers accepted

00453955880 004539558800 to 004539558809

+45395588 004539558800 to 004539558899
88 Restricted dialing
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Troubleshooting 5

In this chapter

In this chapter you can read about:

• Getting support

• Troubleshooting guide

Getting support

If this manual does not provide the remedies to solve your problem, you may 
want to contact your service provider, your aircraft installation and service 
center or your local distributor.

The web interface provides a help desk, event logs and event lists. The system 
can also generate a diagnostic report for service and maintenance purposes.

Airtime support

If you need assistance from your service provider, call the help desk. To see 
the help desk number, enter the web interface of your system and select HELP 
DESK. This displayed help desk number is either taken from the SIM card or 
entered manually. If no number is available under HELP DESK, check the 
documentation of your service provider for a contact number.
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System support

If you need assistance when solving problems caused by the system or 
antenna, please call a distributor in your area. 

A list of certified partners and distributors is available on Thrane & Thrane’s 
web site: www.thrane.com. Select Aeronautical, and select Contacts from the 
top menu bar. Then click Commercial Dealers in the menu to the left.

Accessing the Help desk

If you need help with airtime-related issues you may call the Help desk. By 
default, the Help desk is the phone number for your Airtime Provider, if it is 
available on the SIM card.

To access the Help desk, select HELP DESK from the left navigation pane.

If the Help desk number is available on the SIM card, the number is displayed 
as a link. To change the number, click the link, change the number and click 
Apply.

If you need help with system or antenna related issues call your local 
distributor.
92 Getting support
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Generating a diagnostic report

The AVIATOR 200/300/350 system can generate a diagnostic report. This 
report contains information relevant for the service personnel during 
maintenance and troubleshooting. If you have reason to believe the system is 
malfunctioning you can generate such a report, save it and send it to the 
system responsible.

To generate a diagnostic report, do as follows:

1. Reboot the system.

2. Establish the problem or situation in which the error occurred, or

3. Make a CS call (if possible), i.e. make a call with one of the handsets 
connected.

4. Make a PS call (if possible), i.e. establish a data connection. See Start or 
stop a Standard connection on page 32.

5. Click Generate report from the HELP DESK page. 
In some browsers the file may open directly in your browser. If it does, 
choose File > Save As to save the file.

6. Choose a location for the file and save it on your computer.

7. Send it to your system administrator.

Event logging and self test

The AVIATOR 200/300/350 system logs events and results from self tests. This 
information is useful during maintenance and troubleshooting. For further 
information how to view the event list and the event log and how to make a 
self test see the AVIATOR 200/300/350 Installation and maintenance manual.
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Troubleshooting guide

The below table provides information on some of the problems that might 
occur, including possible causes and remedies to solve the problems.

Problem Possible Cause Remedy

No signal or 
weak signal from 
the BGAN 
satellite.

The view to the 
satellite is blocked.

There might be some temporary 
loss of signal due to parts of the 
plane blocking for a clear view of 
the satellite. This temporary loss of 
signal will pass when the antenna 
has a full view of the satellite 
again.

The system is not 
fully operational.

Wait until the system is powered 
up and fully operational. There 
might be an indicator in the cabin 
indicating that the satcom system 
is ready for use.

The system is set up 
to use a specific 
satellite, but the 
system is outside 
coverage from that 
satellite.

Enter the web interface. Select 
SETTINGS. At Satellite selection. 
Select Auto and click Apply. 

The system will now search for the 
satellite with the strongest signal 
and attempt to connect.
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Connection to 
the Internet 
cannot be 
established.

Your system is 
setup to start a 
connection in the 
web interface 
manually.

Open your Internet browser and 
enter the default IP address of the 
SwiftBroadband Unit: 
http://192.168.0.1 (default address). 
Click Start Standard to open a 
standard data connection 
manually. For more details see 
Start or stop a Standard connection 
on page 32.

WLAN security not 
set up correctly.

Contact your system administrator 
for encryption keys for your 
Wireless interface.

No Wireless in the 
cabin.

You try to make a connection using 
the Wireless access point. This 
feature is not enabled or not 
installed. Use a LAN connection 
instead.

Your network user 
group does not 
allow Internet 
access.

Contact the administrator to 
change your network user group 
to allow Internet access. You might 
need to start a standard data 
connection. See Start or stop a 
Standard connection on page 32.

Problem Possible Cause Remedy
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The web 
interface cannot 
be accessed.

The browser of your 
PC is configured to 
use a proxy server.

For Microsoft Internet Explorer, 
select Tools > Internet Options > 
Connections > LAN Settings and 
uncheck Use a proxy server for 
your LAN.

You have entered a 
wrong IP address.

Check the IP address and re-enter 
it. Default value: http://192.168.0.1.

Send a ping request in the 
command prompt window.

If you do not have the correct IP 
address, contact your system 
administrator.

WLAN security not 
set up correctly.

Contact your system administrator 
for encryption keys for your 
Wireless interface.

No WLAN in the 
cabin.

You try to make a connection using 
WLAN, but there is no WLAN 
antenna in the cabin. Use a LAN 
connection instead.

You are connected 
using a VPN 
connection.

Close down your VPN connection.

Problem Possible Cause Remedy
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A Phone/Fax 
connection 
cannot be 
established.

The phone cable is 
not properly 
connected.

Connect the phone cable.

The cable type or 
connector type is 
not correct.

For information on the correct type 
of connector and cable, refer to the 
installation manual.

Incoming calls: The 
call type used for 
the call is not 
selected in the web 
interface.

Make sure the call type used for 
calls to the system is selected in 
the web interface. Access the web 
interface and select SETTINGS > 
Phone/Fax. Then, for each of the 
two ports, select the call type for 
incoming calls.

The fax machine 
times out.

Set the fax machine to overseas 
mode, allowing for longer time 
intervals before timing out.

If you are located in 
an elevation area < 
45° and you have 
an AVIATOR 300 or 
an AVIATOR 200, 
3.1 kHz Audio 
(Premium voice) is 
not supported.

Use Standard voice in stead of 
3.1 kHz Audio (Premium voice) 
when you are located in areas with 
< 45° elevation.

Problem Possible Cause Remedy
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An ISDN 
connection 
cannot be 
established

The cable is not 
properly connected.

Connect the cable.

You have connected 
to the LAN 
interface.

Connect the cable to the interface 
marked ISDN.

The cable type or 
connector type is 
not correct.

For information on the correct type 
of connector and cable, refer to the 
installation manual.

Incoming phone 
calls: The call type 
used for the call is 
not selected in the 
web interface.

Make sure the call type used for 
calls to the system is selected in 
the web interface. Access the web 
interface and select SETTINGS > 
ISDN. Then select the call type for 
incoming calls.

If you are located in 
an elevation area < 
45° and you have 
an AVIATOR 300 or 
an AVIATOR 200, 
3.1 kHz Audio 
(Premium voice) is 
not supported.

Use another service. You may still 
use the ISDN interface on the 
system, but only Standard voice is 
available.

A LAN 
connection 
cannot be 
established.

The cable is not 
properly connected.

Connect the cable.

You have connected 
to the ISDN 
interface.

Connect the cable to the interface 
marked LAN.

The cable type or 
connector type is 
not correct.

For information on the correct type 
of connector and cable, refer to the 
installation manual.

Problem Possible Cause Remedy
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The 
administrator 
password does 
not work.

The administrator 
password has been 
changed.

If the correct password is not 
found, you have to reset the 
password.

Contact your system administrator, 
then your supplier for a reset code. 
You must provide the serial 
number and IMEI number of the 
SwiftBroadband Unit.

Problem Possible Cause Remedy
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2-Wire Handset use A

Description

The 2-Wire Handset has three sections:

• Light Emitting Diodes (LED) section. This section gives 
you visual indications about the operation and status of 
the system.

• Function keys section. This section gives you access to a 
few call functions, such as transfer of calls, memory etc.

• Alpha-numeric section. This section enables you to dial 
numbers.

The 2-Wire Handset has a volume control placed on the 
side of the handset.

Light emitting diodes

There are two LEDs on the 2-Wire Handset.

• Green LED (left) is constantly on when the handset is off-hook.

• Green LED (right) flashes to indicate that the handset is ringing. When a 
connection is made, the LED is turned off.
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Function keys

Using the function keys you can transfer calls, re-dial, store and recall phone 
numbers, and mute the microphone. The following table describes each 
function key.

Alpha-numeric keys

The numeric keys are primarily used to dial numbers 
or to enter numbers to be stored in memory.

Key Function

G Store number. This key is used to store phone numbers.

H Memory. This key is used to recall phone numbers from the 
memory.

F Transfer call. This key is used to transfer an incoming call to 
another handset.

A Memory location 1. (Same function as H J)

B Memory location 2. (Same function as H K)

C Memory location 3. (Same function as H L)

D Redial. This key is used to redial the last dialled number.

E Mute. This key is used to mute the microphone.

I Toggle hook. This key is used to toggle between on-hook and 
off-hook.
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List of available characters and functions

Key Available Characters or Functions

J 1

K 2 a b c

L 3 d e f

M 4 g h i

N 5 j k l

O 6 m n o

P 7 p q r s

Q 8 t u v

R 9 w x y z

S Special function 

T 0

U This key is used to indicate the end of a phone number or to 
activate a call.
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Operation

Making a call with the 2-Wire Handset 

Making a call from a normal 2-wire POTS phone connected to one of the two 
analogue POTS phone interfaces is done in the same way as a call from a 
standard telephone, but always with the prefix 00 and U after the number 
to signal to the SwiftBroadband Unit, that the number is complete. 

Example: To call Thrane & Thrane inc. in USA (country code 1) first establish 
a connection by pressing  or taking the handset off the cradle. 
Then press the following keys on the phone:

TTJPNPMOLRNNPU

To learn how to make local calls see Making local phone calls on page 41.

Answering a call with the 2-Wire Handset

Answering a call to the Auxiliary handset can be done in two ways:

• If the handset is in the cradle, simply take the handset from the cradle to 
answer the call.

• If the handset is out of the cradle, press  to answer the call.

Managing phone numbers in the 2-Wire Handset

The Auxiliary handset can store up to 10 phone numbers, in memory location 0 
to 9. The A, B and C keys can be used for accessing memory location 
1, 2 and 3, whereas the other locations are accessed using the MEM key 
followed by the number of the location. 
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To store a number using A, B and C 

Do as follows:

1. Press  or take the handset off the cradle.

2. Press G.

3. Enter the phone number you want to store, including country code.

4. Press G.

5. Press A, B or C depending on the memory location you want to 
save the number in.
The number is now available in the memory location you selected.

Example: To save the phone number of Thrane & Thrane inc. in memory 
location 2, take the handset off the cradle and press the 
following keys:

G
TTJPNPMOLRNNP
G
B

To store a number using the number keys

Do as follows:

1. Press  or take the handset off the cradle.

2. Press G.

3. Enter the phone number you want to store, including country code.

4. Press G.

5. Press one of the keys 0 to 9, depending on the memory location you want 
to save the number in.
The number is now available in the memory location you selected.

Example: To save the phone number of Thrane & Thrane inc. in memory 
location 8, take the handset off the cradle and press the following 
keys:
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G
TTJPNPMOLRNNP
G
Q

To recall a number using A, B and C

To recall a phone number from memory location 1, 2 or 3 using the A, B 
and C keys, do as follows:

1. Press  or take the handset off the cradle.

2. Press A, B or C, depending on which memory location you want.
The number saved in the memory location is dialled.

Example: To call the number saved in memory location 3, first establish a 
connection by pressing  or taking the handset off the cradle. 
Then press C. The number saved in memory location 3 is 
dialled.

To recall a number using H and the number keys

To recall a phone number from memory using the H key, do as follows:

1. Press I or take the handset off the cradle.

2. Press H followed by the number of the memory location you want.
The number saved in the memory location is dialled.

Example: To call the number saved in memory location 8, first establish a 
connection by pressing I or taking the handset off the cradle. 
Then press H Q. The number saved in memory location 8 is 
dialled.

Note Pressing A has the same effect as pressing H J.
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Transferring a call with the 2-Wire Handset

You can receive a call on a 2-Wire Handset and transfer the call to another 
handset. 

To transfer a call do as follows:

1. When an incoming call is received, answer the call as usual with I or 
simply lift the handset from the cradle.

2. Place the call on hold with F.

3. Dial the Interface Code of the desired handset, e.g. K for Handset #2.

4. Initiate handset to handset call with U.
You have now established an active call from handset to handset, and you 
can give a short message.

5. Route the incoming call to the new handset by pressing I, or placing 
the handset in the cradle.

Re-dialing a number

To call the last dialled number, first establish a connection by pressing I or 
taking the handset off the cradle. Then press D followed by U.

Muting the microphone of the 2-Wire Handset

To mute the microphone of the handset, press E. To return to normal 
microphone function, press E again.
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Glossary B
B

Gl
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ry
A

AMBE Advanced Multi-Band Excitation. Speech coding standard used by 
the Inmarsat satellite telephony system. 

AMER Americas (Satellite coverage) 

ANSI American National Standards Institute, facilitates the voluntary 
establishment of standards. 

APAC Asia Pacific (Satellite coverage) 

C

CS Circuit-Switched. Circuit-switched networks require dedicated 
point-to-point connections during calls. 

D

DHCP Dynamic Host Configuration Protocol for assigning IP addresses to 
devices on a network. 

E

EMEA Europe, Middle East, Africa (Satellite coverage) 

F

FNBDT Future Narrowband Digital Terminal. A US Government standard 
for secure voice communication. 

I

IEEE Institute of Electrical and Electronics Engineers 
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IMEI International Mobile Equipment Identity. A unique number 
identifying your terminal 

IMSI International Mobile Subscriber Identity) 

IMSO International Maritime Satellite Organization 

IP Internet Protocol, used for communicating data across a packet-
switched internetwork. 

ISDN Integrated Services Digital Network 

ISP Inmarsat Service Provider 

K

kbps kilobits per second 

L

LAN Local Area Network 

LGA Low Gain Antenna 

M

MB Mega Bytes 

N

NAT Network Address Translation. In the BGAN network you can have 
one public IP address and several private IP addresses. 

P

PBX Private Branch Exchange, a telephone system that switches calls 
between users on local lines. 
110



Glossary
B
B
B
B
B

Gl
os

sa
ry

SBLiteUM.book  Page 111  Tuesday, March 13, 2012  1:44 PM
PBX Private Branch Exchange, telephone exchange that serves a 
particular business or office. 

POTS Plain Old Telephone Service 

PS Packet-Switched. Packet-switched networks move data in 
separate, small blocks (packets) based on the destination address 
in each packet. 

R

RDI Restricted Digital Information 

S

SB SwiftBroadband. Simultaneous voice and broadband data up to 
432kbps per channel. 

SIP Session Initiation Protocol for setting up, controlling and closing 
sessions in the Internet. These sessions include Internet 
telephone calls, instant messaging and multimedia conferences. 

SMS Short Messaging Service 

STE Secure Terminal Equipment 

STU Secure Telephone Unit 

T

TCP Transmission Control Protocol. One of the core protocols of the 
Internet protocol suite. TCP provides reliable, in-order delivery of 
a stream of bytes, making it suitable for applications like file 
transfer and e-mail. 
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U

UDI Unrestricted Digital Information 

UTC Coordinated Universal Time. The International Atomic Time (TAI) 
with leap seconds added at irregular intervals to compensate for 
the Earth’s slowing rotation. Leap seconds are used to allow UTC 
to closely track UT1, which is mean solar time at the Royal 
Observatory, Greenwich. 

V

VPN Virtual Private Network, e.g. secure communications through the 
public Internet. 

W

WLAN Wireless Local Area Network 
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Numerics

2-Wire handset and cradle, 8
2-wire interface

local numbers, 42
3.1 kHz audio, 5

A

activation
remote, 86

activation SMS, 87
address

manufacturer, ii
airtime

unintended user of, 29
allowed numbers

restricted dialling, 88
analog phone

local numbers, 42
answering a call

Thrane & Thrane handsets, 104
applications, 1
audio quality, 35
automatic shut down

connection, 81
AVIATOR phone number, 73

B

bit rates
streaming class, 3

browser settings
for web interface, 62

browsers supported, 62
C

call
from 2-wire handset, 101
from POTS handset, 101
transfer, 2-Wire handset, 106

call costs
SIP-enabled IP phone, 51

call limiting, 88
call log, 74

clear, 80
reset, 80

call type, 35
calls

forwarding, 47
holding, 45
local, 41
making or receiving, 38
missed, received, outgoing, 75
redial, 42
to the terminal, 40
transferring, 46
viewing ongoing, 70
waiting indication, 44

charges
SIP-enabled IP handset, 53

Class 15
services, 3

Class 6
services, 3

Class 7
services, 3

clear
call log, 80

clearing logs, 80, 81
clearing usage counter, 80, 81
codec priority, 52
commissioning, 13
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conference call
SBU, 46

connection
activate, 32
automatic shut down, 81

contact
address, ii

contact information, 91
cordless phone, 8
coverage

elevation angles, 4

D

dashboard, 68
data connection

start, 32
stop, 32

data limit
automatic shutdown, 81

data session
start, 77
stop, 77

data sessions
viewing ongoing, 70

deactivation SMS, 87
default IP address, internal, 28
DHCP, 5
dial

numbers in phone book, 42
dialing prefixes, 43
dialling restrictions, 88
document number

this manual, i
documents

related, vi
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E

elevation angles, 4
encryption key, 19
external IP address, 70, 84

F

fax
how to use, 35

fax, sending or receiving, 49
features, 2, 5
Flex key for options, 6
forwarding calls, 47

G

G3 fax machine, 35
G4 fax or data, 35
geostationary satellites, 9
GPS position, 69

H

help desk number, 92
changing in web interface, 92

HGA
services, 3

High Gain Antenna, 3
holding a call, 45

I

ICGT DECT Cordless
phone system, 8

IGA
services, 3
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IMSI number, 69
Inbox for SMS messages

replying, forwarding or deleting, 58
Inmarsat, 9
installation and maintenance manual

order number, vi
interfaces, 2, 6

LAN and WLAN, 26
Intermediate Gain Antenna, 3
internal calls, 41
IP address

BGAN network, 84
default, internal, 28
external, 70, 84
for web interface, internal, 65

IP data connection, 31
IP handset, 7

local numbers, 42
ISDN

limitations for IGA, 4
local numbers, 42

ISDN number, 73
ISDN plug, 35

L

LAN
managing network users, 26

LGA
services, 3

limit
allowed MB, 81
data, 30, 81
streaming class, 30, 81

limit calls, 88
local exchange, 83
local numbers assigned, 42
local phone call, 41
logs, clearing, 80, 81
Low Gain Antenna, 3

M

MAC address, 27
maintenance connector, 6
maintenance manual

order number, vi
manual

document number, i
manufacturer

address, ii
memory

2-wire handset, 104
messages

configuring outgoing, 59
forwarding, 58
opening in web interface, 58
receiving in web interface, 57
replying, 58
sending, 56

mobile numbers
viewing and editing, 73

multi-party call, SBU, 46

N

navigation in web interface, 67
Network Address Translation, 5
network management, 26
network user group, 27

O

order number
manuals, vi
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Outbox for SMS messages
resending or deleting messages, 55

P

password
SIP phone, 52

phone
how to use, 35
local call, 41
making calls, 38

phone book, 71
limited numbers, 88

phone number, 73
phone numbers for SwiftBroadband
Unit, 73
Phone/Fax interface

local numbers, 42
POTS phone, 101
preferred satellite, 78
prefixes, special-purpose, 43
profiles, 27
Proxy server, disabling, 62

Q

quality of voice, 35
Quick dial, 38
quick guide

order number, vi

R

radiation warning, iii
Realm, 52
recalling a stored number

2-wire handset, 106
116
redial, 42
2-wire handset, 107

reduce airtime cost, 29
remote activation

by SMS, 87
trusted mobile number, 87

remote control, 86
remote management

accessing, 84
preparation, 84

reset
call log, 80

restricted dialling, 88
router functionality, 6

S

safety summary, iii
satellite

automatic handover, 78
coverage, 4
preferred, 78
selecting, 78
view selected, 69

satellites
footprint, 9
Inmarsat, 9

seat-to-seat
dialing, 42

security key
WLAN, 19

sent messages
resending, forwarding or deleting, 56
viewing status, 56

serial number, 69
Server name

SIP server, 52
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service and maintenance
connector, 26

services, 2
Short dial, 38
Sigma7

handset and cradle, 8
SIP client, 51

where to get, 51
SIP server

codec priority, 52
connect to, 52
name, 52
password, phone, 52
realm, 52

SIP-enabled IP handset
server name, 52
setting up, 52
using, 53

site map, 24
SMS

activation, 87
deactivation, 87

SMS activation, 87
SMS in web interface

forwarding, 58
opening, 58
receiving, 57
replying to, 58
sending, 56

SMS service center
number, 59, 60

software
version number, v

software version, v
SBU Level D, v
SBU Level E, v

spot-beams, 9
SSID, 19
Standard data
activating, 32

Standard IP
activate, 32

Standard IP data connection, 31
standard voice

phone number, 73
status, 69

ongoing calls and data sessions, 70
viewing, 68

storing a phone number
2-wire handset, 104

streaming, 3
streaming class

bit rates, 3
time limit, 81

streaming classes, 3, 31, 33
streaming connection

start, 33
stop, 34

streaming data
total, 70

Streaming IP data, 31
streaming rates, 3, 33
streaming session

startor stop, 34
supplementary services

supported, 14
using, 44

support
contact information, 91

SwiftBroadband service, 9
system status info, 69
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telephone interface
local numbers, 42

tools for setting up the terminal, 23
total usage

viewing, 70, 74
transferring a call, 46

2/Wire handset, 106
troubleshooting guide, 94
trusted mobile number, 87
typography used in this manual, vi
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usage counter, 70, 74
clearing, 80, 81

user interfaces, 23
user name

SIP server, 52
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voice mail, 21, 41
number, 59, 76

voice quality, 35
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waiting calls, 44
warning

radiation, iii
web interface, 7

accessing, 62
browser settings, 62
navigating, 67

Wireless, 6
Wireless Handset and Cradle, 7
wireless network
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network name, 19
security key, 19

WLAN option, 6
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